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の内容は、次のとおりです。

の リ リースの新機能（1-1 ページ）

ポー ト されている構成（1-2 ページ）

連資料（1-2 ページ）

のマニュアルの使い方（1-3 ページ）

isco IronPort Email Security Plug-in の概要（1-7 ページ）

の新機能
リースには、次の新機能が含まれています。

isco Ironport Email Security Plug-in の設定から、Cisco Ironport 暗号化ア
ラ イアンス（IEA）または Cisco Registered Envelope Service（CRES）を
ステッ ド  キー サーバと して使用するよ うに指定可能。

utlook 2010 64 ビッ ト のサポート 。
1-1
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動設定。Cisco Ironport Email Security Plug-in は、管理者から受信した 
ML 添付ファ イルによって自動的に設定されます。

子メール アカウン ト ご との設定。Cisco Ironport Email Security Plug-in 
、電子メール アカウン ト ご との設定を決定する  3 種類のモード
ecrypt Only、Flag、Encrypt）で展開されます。
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• デスク ト ップ暗号化のセキュア  エンベロープ オプシ ョ ン。

– 暗号化された電子メールのロ ッ ク またはロ ッ ク解除。エン ド  ユー
ザは、暗号化された電子メールをロ ッ ク またはロ ッ ク解除できま
す。また、暗号化された電子メールをロ ッ クする理由を設定した り
変更した りする こ とができます。

– 暗号化された電子メールの失効日時の設定 エンド  ユーザは、失効
日時を設定した り ク リ アした りする こ とができます。

ート されている構成 
『CCisco Encryption Compatibility Matrix』にはサポート されているオペレー
テ ィ ング  システムが掲載されており、次の URL からアクセスできます。

http://www.cisco.com/en/US/docs/security/iea/Compatibility_Matrix/IEA_Com
patibility_Matrix.pdf

資料
暗号化プラグインを使用するには、暗号化プラグイン と連携するよ うに適
切に設定された Cisco IronPort 暗号化アプラ イアンスを実行しているか、
Cisco Registered Envelope Service（CRES）アカウン ト を所有している必要が
あ り ます。Cisco IronPort Encryption アプラ イアンスの設定方法の詳細につ
いては、次のマニュアルを参照して ください。

• 『 IronPort Encryption Appliance Installation Guide』。このマニュアルでは、
電子メール暗号化のインス トールおよび設定手順について説明してい
ます。プラグインの設定と連動するよ うに暗号化アプラ イアンスを設
定する方法を理解する上で役立ちます。次を参照して ください。

http://www.cisco.com/en/US/products/ps10154/prod_installation_guides_list.html

Cisco IronPort Email Security の動作についての理解を深めるために、電子
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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メールをスパム、ウ イルス、または非スパム と して分類する方法に関する基
本情報を確認する こ と を推奨します。これらのテーマの詳細については、次
のマニュアルを参照して ください。

http://www.cisco.com/en/US/docs/security/iea/Compatibility_Matrix/IEA_Compatibility_Matrix.pdf
http://www.cisco.com/en/US/products/ps10154/prod_installation_guides_list.html
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• 『Cisco IronPort AsyncOS for Email Configuration Guide』。このマニュアル
では、スパムおよびウイルスからの保護について説明しています。ユー
ザは、スパム と ウイルス用のプラグインを使用して  SenderBase ネッ ト
ワークの効率を向上させる こ とができます。電子メールに「スパム」、
「ウ イルス」、または「非スパム」のマークを設定する こ とによって、フ ィ
ルタの効果を高め、すべての Cisco IronPort アプラ イアンスのパフォー
マンスを向上させる こ とができます。次を参照して ください。

http://www.cisco.com/en/US/products/ps10154/products_user_guide_list.html

マニュアルの使い方
このマニュアルは、Cisco IronPort Email Security Plug-in の機能について学習
するための リ ソース と して使用して ください。マニュアルの内容は論理的
な順序で構成されていますが、すべての章を読む必要はあ り ません。目次お
よびこのマニュアルの構成（1-3 ページ）を読んで、ご使用の設定に関連する
章を確認して ください。

このマニュアルは PDF 形式で電子的に配布されています。このマニュアル
の電子バージ ョ ンは、Cisco IronPort カスタマー サポート  ポータルで入手で
きます。また、アプラ イアンスの GUI で HTML オンラ イン  ヘルプ ツールに
アクセスできます。

• Outlook 2010 では、[Tools] > [Options] > [Cisco Email Security] の順に移
動します。Outlook で [Help] ボタンをク リ ッ ク して、[Actions] > [Cisco 
Email Security] をク リ ッ ク します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] > 
[Help] の順に移動します。

マニュアルの構成

第 1 章「Cisco IronPort Email Security Plug-in の準備」では、Cisco IronPort セ
1-3
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キュ リ テ ィ  プラグインの概要について説明し、ネッ ト ワーク  セキュ リ テ ィ
設定で主要機能および役割を定義します。最新リ リースの新機能、その他の
情報リ ソース、およびサポート問い合わせ情報について説明します。

第 2 章「概要」では、レポー ト  プラグイン と暗号化プラグインについて紹介
します。この項には各ツールの概要が示されています。

http://www.cisco.com/en/US/products/ps10154/products_user_guide_list.html
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詳細

セキ
第 3 章「一括インス トールの実行」では、一括インス トールの実行方法につ
いて説明します。インス トールを実行する手順が示されています。

第 4 章「Cisco IronPort Email Security Plug-in for Outlook の設定と使用」では、
Cisco IronPort Email Security Plug-in for Outlook の設定手順について説明し
ます。暗号化プラグインのインス トール、暗号化された電子メールの送受
信、セキュア  メ ッセージの管理に関する手順も含まれています。

付録 A「Cisco IronPort Systems, LLC Software License Agreement」には、Cisco 
IronPort 製品の使用許諾契約に関する詳細な情報が掲載されています。

情報の入手先

シスコでは、Cisco IronPort Email Security Plug-in について理解を深めるため
の次の リ ソースを用意しています。

ュリテ ィ  ト レーニング サービスと認定

シスコ  セキュ リ テ ィ  ト レーニング  サービスでは、シスコの製品と ソ リ ュー
シ ョ ンを使用するための比類のない指導と ト レーニングを行っています。
技術的な ト レーニング  コース用の的確なカ リ キュ ラムを通じて、このプロ
グラムでは、さ まざまな利用者向けの最新の知識と スキルが伝わり ます。

シスコ  セキュ リ テ ィ  ト レーニング  サービスに連絡するには、次のいずれか
の方法を使用して ください。

ト レーニング。 登録と一般ト レーニングに関しては、次の URL でアクセス
して ください。

• http://training.ironport.com

• stbu-trg@cisco.com

認定。認定と認定試験に関しては、次の URL でアクセスして ください。

• http://training.ironport.com/certification.html 
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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• stbu-trg@cisco.com

http://training.ironport.com
stbu-trg@cisco.com
http://training.ironport.com/certification.html 
stbu-trg@cisco.com
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次の URL から  Cisco IronPort カスタマー サポート  サイ ト の Cisco IronPort 
ナレッジ ベースにアクセスできます。

http://www.cisco.com/web/ironport/knowledgebase.html

ナレッジ ベースには、Cisco IronPort 製品に関する ト ピ ッ クについて豊富な
情報が用意されています。

通常、記事は次のカテゴ リのいずれかに分類されています。

• 手順：手順の項目では、Cisco IronPort 製品を使用して何かを実行する方
法について説明します。たとえば、How-To の記事では、アプラ イアンス
用データベースのバッ クアップを と り、復元する手順について説明し
ます。

• 問題と解決策：問題と解決策の項目では、Cisco IronPort 製品の使用時に
発生する可能性があるエラーや問題に対処します。たとえば、
Problem-and-Solution の記事では、製品の新バージ ョ ンへのアップグ
レード時に特定のエラーメ ッセージが表示された場合の対応方法につ
いて説明します。

• 参考資料：Reference の記事は、通常、特定のハード ウェアに関連するエ
ラー コードなど情報の リ ス ト を提供します。

• ト ラブルシューテ ィ ング： ト ラブルシューテ ィ ングの項目では、Cisco 
IronPort 製品に関連する一般的な問題を分析し、解決する方法について
説明します。たとえば、Troubleshooting の記事は、DNS で問題が発生し
た場合に従う手順を提供します。

コ  サポート  コ ミ ュニティ

シスコ  サポート  コ ミ ュニテ ィは、シスコのお客様、パートナー、および従業
員のオンラ イン  フォーラムです。電子メールおよび Web セキュ リ テ ィに関
する一般的な問題や、特定のシスコ製品に関する技術情報について話し合
う場を提供します。フォーラムに ト ピ ッ クを投稿して質問した り、他のシス
1-5
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コ  ユーザや Cisco IronPort ユーザと情報を共有した りできます。

シスコ  サポート  コ ミ ュニテ ィには次の URL からアクセスできます。

https://supportforums.cisco.com

http://www.cisco.com/web/ironport/knowledgebase.html
https://supportforums.cisco.com 
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Cisco

Cisc
 カスタマー サポート  

注 利用可能なサポート のレベルは、お客様のサービス  レベル契約によって異
な り ます。Cisco IronPort カスタマー サポート のサービス  レベル契約の詳細
については、サポート  ポータルをご覧ください。サポート  レベルの詳細に
ついては、このページで確認して ください。

サポートは、電話、電子メール、またはオンラ インで依頼できます（24 時間
年中無休）。次のいずれかの方法で Cisco カスタマーサポート にお問い合わ
せください。

• Cisco サポート  ポータル：http://www.cisco.com/support

• 電話サポート ：800-553-2447（米国/カナダ国内）または Worldwide Phone 
Numbers から  Cisco Technical Assistance Center（TAC）にお問い合わせく
ださい。

• 電子メール：tac@cisco.com

再販業者または別のサプラ イヤからサポート を購入した場合は、製品のサ
ポート の問題について直接そのサプラ イヤに連絡して ください。

o Content Security にコメン ト をお寄せください

Cisco Content Security テクニカル マニュアル チームは、製品ドキュ メ ン ト
の向上に努めています。コ メ ン トおよびご提案をお待ちしています。コ メ ン
トは次の電子メール アド レス宛に送信できます。 

contentsecuritydocs@cisco.com 
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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http://www.cisco.com/support
http://www.cisco.com/en/US/support/tsd_cisco_worldwide_contacts.html#telephone
http://www.cisco.com/en/US/support/tsd_cisco_worldwide_contacts.html#telephone
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o IronPort Email Security Plug-in の概要
Cisco IronPort Email Security Plug-in では、Outlook 電子メール プログラムに
レポート と暗号化のメニューがインス トールされます。レポー ト  プラグイ
ンを使用する と、受信したメールの種類についてフ ィードバッ クを送信で
きます（たとえば、スパム、フ ィ ッシング、ウ イルスなどが含まれている電子
メールを報告できます）。また、暗号化プラグインをインス トールする と、
ツールバーに [Encrypt Message] ボタンが表示されます。ユーザはこのボタ
ンを使って、電子メール プログラムから暗号化した電子メールを送信した
り、組織外に送信する前に暗号化する電子メールにフラグを設定する こ と
ができます。

Cisco IronPort Email Security Plug-in をインス トールする と、Outlook メール 
ク ラ イアン ト上のコンポーネン ト が有効にな り ます。この単一のインター
フェイスを使って、エン ドユーザは電子メールをシームレスに報告した り、
暗号化された電子メールを送信する こ とができます。エン ド  ユーザは、暗
号化した電子メールをロ ッ ク またはロ ッ ク解除した り、ロ ッ クの理由を追
加または変更する こ とができます。また、暗号化された電子メールの失効日
時を設定する こ と もできます。これらのプラグインを組み合わせる と、イン
ス トールが簡単にな り、ユーザと管理者は 1 つのインターフェイスから イ
ンス トールや変更を行う こ とができるよ うにな り ます。

レポー ト  プラグインおよび暗号化プラグインは、ツールバー ボタン と右ク
リ ッ ク  コンテキス ト  メニューを使用してフ ィードバッ クおよび暗号化さ
れたメ ッセージを送信できる便利なインターフェイスです。レポー ト  プラ
グインを使用して メ ッセージを報告する と、メ ッセージが送信されたこ と
を示すダイアログボッ ク スが表示されます。暗号化プラグインをインス
トールする と、電子メール メ ッセージのメニュー バーに [Encrypt Message] 
ボタンが表示されるので、送信者は暗号化されたメ ッセージを簡単に送信
できます。暗号化プラグインを使用するには、適切に設定された Cisco 
IronPort 暗号化アプラ イアンスが存在しているか、または、Cisco Registered 
Envelope Service（CRES）のアカウン ト を所有している必要があ り ます。
1-7
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 IronPort Email Security Plug-in は、レポート  プラグインや暗号化プラ
など、複数の Cisco IronPort Email Security Plug-in をサポートするフ
ワークです。

の内容は、次のとおりです。

isco IronPort Email Security Plug-in（2-2 ページ）

ラグインのインス トール（2-3 ページ）

ンフ ィギュレーシ ョ ン  モード（2-3 ページ）

isco Registered Envelope Service（CRES）キー サーバ用の Cisco IronPort 
mail Security Plug-in の導入（2-5 ページ）

onPort 暗号化アプラ イアンス（IEA）キー サーバ用の Cisco IronPort 
mail Security Plug-in の導入（2-7 ページ）

isco IronPort Email Security Plug-in の設定（2-9 ページ）

isco IronPort Email Security Plug-in に必要な TCP/IP サービス
-10 ページ）
2-1
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 Cis

レポ
co IronPort Email Security Plug-in
Cisco IronPort Email Security Plug-in は、よ く使用される  2 つの電子メール セ
キュ リ テ ィ  プラグイン（レポート  プラグインと暗号化プラグイン）から構成
されています。Cisco IronPort Email Security Plug-in は Outlook 電子メール プ
ログラムに導入できます。Cisco IronPort Email Security Plug-in を導入する と、
次のアプ リ ケーシ ョ ンのいずれか（または両方）がインス トールされます。

• Reporting Plug-in：レポー ト  プラグインを使用する と、Outlook ユーザ
は、スパム、ウ イルス、フ ィ ッシング  メ ッセージなど、一方的に送りつ
けられる不要な電子メール メ ッセージについて  Cisco IronPort Systems 
にフ ィードバッ クを送信できます。詳細については、レポー ト  プラグ
イン（2-2 ページ）を参照して ください。

• Encryption Plug-in：暗号化プラグインをインス トールする と、電子メー
ル メ ッセージのメニュー バーに [Encrypt Message] ボタンが表示され
るので、送信者は暗号化が必要なメ ッセージを簡単にマークできます。
詳細については、暗号化プラグイン（2-3 ページ）を参照して ください。

ート  プラグイン

レポート  プラグインを使用する と、Outlook ユーザは、スパム、ウ イルス、
フ ィ ッシング  メ ッセージなど、一方的に送りつけられる不要な電子メール 
メ ッセージについて Cisco IronPort Systems にフ ィードバッ クを送信できま
す。Cisco IronPort では、このフ ィードバッ クを活用してフ ィルタを更新し、
不要なメ ッセージが受信ト レイに配信されないよ うにします。

さ らに、[Not Spam] ボタンを使用して、誤検出（誤ってスパムと してマーク さ
れた正当な電子メール メ ッセージ）を  IronPort Systems に報告するこ と もで
きます。正当な電子メール メ ッセージは「ハム」と も呼ばれます。シスコで
は、誤検出に関するレポート を活用してスパム  フ ィルタを調整し、今後、正
当な電子メールが誤分類されないよ うにします。あらゆる正当な電子メール
を「非スパム」と して報告できるので、フ ィルタの効率向上に役立ちます。

このプラグインは、ツールバー ボタン と右ク リ ッ ク  コンテキス ト  メニュー
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を使用してフ ィードバッ クを送信できる便利なインターフェイスです。
メ ッセージを報告する と、メ ッセージが送信されたこ とを示すダイアログ
ボッ ク スが表示されます。送信したメ ッセージ  データは、Cisco IronPort 
フ ィルタを改善するために自動システムによって使用されます。メ ッセー
ジ データを提出する こ とで、受信ボッ ク スに一方的に送りつけられる メー
ルの量を削減できます。
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暗号化

プラ

コン
プラグイン

暗号化プラグインをインス トールする と、電子メール メ ッセージのメ
ニュー バーに [Encrypt Message] ボタンが表示されるので、送信者は、組織
外部に送信する前に、暗号化して保護する必要がある メ ッセージを簡単に
マークできます。

2 種類の暗号化（Flag 暗号化とデスク ト ップ暗号化）を使用できます。Flag 
暗号化オプシ ョ ンを使用する と、暗号化する電子メールにフラグを設定で
きます。電子メールは、Cisco IronPort 暗号化アプラ イアンスまたは電子メー
ル セキュ リ テ ィ  アプラ イアンスによって暗号化されてから、ネッ ト ワーク
の外部に送信されます。デスク ト ップ暗号化では、Cisco IronPort 暗号化テク
ノ ロジーを使用して電子メール プログラム内から電子メールを暗号化で
きます。その後、暗号化された電子メールが電子メール プログラムによ り
デス ク ト ップから送信されます。デスク ト ップ暗号化は、組織内で送信する
メールを暗号化する場合に使用できます。

暗号化プラグインは、機能している設定済みの Cisco IronPort 暗号化アプラ
イアンス、または Cisco IronPort 電子メール セキュ リ テ ィ  アプラ イアンス
（ネッ ト ワーク内に存在している場合）と連動するよ うに設計されていま
す。暗号化プラグインに使用するコンフ ィギュレーシ ョ ンは、これらのアプ
ラ イアンスの設定に合わせて設定する必要があ り ます。これらのアプラ イ
アンスに同じ設定を使用しないと、暗号化メ ッセージを送信する と きに問
題が生じる可能性があ り ます。

グインのインストール
ユーザ グループ向けに Cisco IronPort Email Security Plug-in をインス トール
する場合、サイレン ト  インス トールを実行できます。サイレン ト  インス
トールでは、エン ド  ユーザに入力を求める こ とな く インス トールを実行で
きます。サイレン ト  インス トールの詳細については、第 3 章「一括インス
トールの実行」を参照して ください。
2-3
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フ ィギュレーショ ン モード
Cisco IronPort Email Security Encryption Plug-in は 3 種類のコンフ ィギュ
レーシ ョ ン  モードで導入されます。デフォル ト のコンフ ィギュレーシ ョ ン  
モードは Decrypt Only です。
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他のコンフ ィギュレーシ ョ ン  モードを有効にするには、更新済みの添付
ファ イルを管理者から受け取り、それを使用して  Outlook 電子メール アカ
ウン ト を設定します。管理者は、エン ド  ユーザの電子メール アカウン ト に 
BCE_Config_signed.xml 添付ファ イルを送信します。エン ド  ユーザはこの
ファ イルを  securedoc.html ファ イルと して受信します。エン ド  ユーザが 
securedoc.html 添付ファ イルをク リ ッ クする と、メ ッセージに添付されてい
る設定情報が Outlook アプ リ ケーシ ョ ンによって検出され、更新済みの設
定が適用されます。

（注） デフォル ト のエンベロープ名は securedoc.html です。添付ファ イル名の値は
管理者が変更でき、指定された新しい名前がエンベロープに反映されます。

3 つのコンフ ィギュレーシ ョ ン  モードは次のとおりです。

• Decrypt Only：受信した安全な電子メール メ ッセージを復号化できます。

• Decrypt and Flag：安全な電子メール メ ッセージの復号化とフラグ設定
を行う こ とができます。フラグ  オプシ ョ ンを使用する と、エン ド  ユーザ
は暗号化が必要な電子メールにフラグを設定できます。電子メールは、
Cisco IronPort 暗号化アプラ イアンスまたは電子メール セキュ リ テ ィ  
アプラ イアンスによって暗号化されてから、ネッ ト ワークの外部に送
信されます。フラグが設定されたメ ッセージを検出してサーバで復号
化できるよ うサーバの設定を行う必要があ り ます。

• Decrypt and Encrypt：安全な電子メール メ ッセージの暗号化と復号化
を行う こ とができます。

次の表は、各コンフ ィギュレーシ ョ ン  モードでサポート される機能を示し
ています。

機能

Decrypt 
Only

Decrypt 
and Flag

Decrypt and 
Encrypt

暗号化したメ ッセージを送信 X

メ ッセージに暗号化フラグを X
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド

OL-22158-03-J

設定

暗号化された電子メールを開封 X X X

返信/すべてに返信/転送 X

電子メールのロ ッ クおよびロ ッ
ク解除

X
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o Registered Envelope Service（CRES）キー 
バ用の Cisco IronPort Email Security Plug-in 
入

Cisco IronPort Email Security Plug-in を  Cisco Registered Email Service
（CRES）キー サーバで直接使用できるよ う にするには、次の手順に従って
導入します。

まず、https://res.cisco.com/admin で CRES アカウン ト にログインし、
[Accounts] タブに移動します。Email Security Plug-in を有効にするアカウン
ト を選択します。次に、[BCE Config] タブに移動します。

ステップ 1 設定テンプレート で使用する トークンを選択します。

• [CRES]：キー サーバが CRES の場合に選択します。

– [SecureCompose]：CRES トークン と してこのオプシ ョ ンを選択しな
いでください。

– [Token <Account number>]：CRES トークン と してこのオプシ ョ ンを

電子メールの有効期限 X

電子メールの診断
（レポー ト  プラグイン と暗号化
プラグインで使用）

X X X

開封確認 X

エンベロープ設定 X

設定 X X X

機能

Decrypt 
Only

Decrypt 
and Flag

Decrypt and 
Encrypt
2-5
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選択します。

ステップ 2 [Download Template] をク リ ッ ク して、編集するテンプレー ト  ファ イルをダ
ウンロード します。ファ イル名は BCE_Config.xml です。

https://res.cisco.com/admin
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ステップ 3 コンフ ィギュレーシ ョ ン  ファ イルを編集します。

BCE_Config.xml ファ イルには、特定の環境に合わせて編集する必要がある
フ ィールドの詳細が含まれています。テキス ト  エディ タでファ イルを開
き、コ メ ン ト に記載されている手順に従って必要な変更を行います。

（注） ローカ リゼーシ ョ ンが目的の場合は、既存のメ ッセージ  セキュ リ テ ィ  ラベ
ル（Low、Medium、High）を変更しないでください。

ステップ 4 [Browse] をク リ ッ ク して、編集した BCE_Config.xml ファ イルを探し、ファ
イルが見つかったら  [Upload and Sign] をク リ ッ ク します。

コンフ ィギュレーシ ョ ン  ファ イルに署名する と、その署名したバージ ョ ン
が BCE_Config_signed.xml と してダウンロード されます。このファ イルを
ローカル マシンに保存します。

ステップ 5 同時に多数のエンド  ユーザにコンフ ィギュレーシ ョ ン  ファ イルを展開す
るには、[Distribute Signed Configuration to Bulk List] オプシ ョ ンを使用しま
す。次の手順を実行します。

a. ステップ 4 で作成した BCE_Config_signed.xml ファ イルの場所を参照
します。

b. エンド  ユーザの電子メール アド レスが含まれているカンマ区切り形式
のファ イルの場所を参照します。

c. 必要に応じて電子メールの件名を変更します。

d. [Distribute Config] をク リ ッ ク します。

（注） XML コンフ ィギュレーシ ョ ン  ファ イルが他のエンド  ユーザに転送された
場合は、管理者から受け取った場合とは異な り、自動設定が機能せず、エ
ラーが返されます。
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（注） メーリ ング  リ ス ト宛てに BCE_Config_signed.xml ファ イルを送らないでく
ださい。CRES はメーリ ング  リ ス ト に対応していません。
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Port 暗号化アプライアンス（IEA）キー サー
の Cisco IronPort Email Security Plug-in の

ー サーバのトークンのダウンロード

設定に署名するプロセスでは IEA トークンを使用する必要があ り ます。コ
ンフ ィギュレーシ ョ ン  フ ァ イルに署名する前に、ローカル マシンに トー
クンをダウンロード します。

IEA キー サーバから トークン  ファ イルをダウンロードするには、次の手順
を実行します。

ステップ 1 IEA 管理コンソールにログインします：https://<IEA_hostname>/admin 。管理
コンソールが表示されます。

ステップ 2 [Accounts] タブに移動します。プラグインのインス トールに使用するアカ
ウン ト に移動します。通常、これは Users アカウン ト です。

ステップ 3 [Tokens] タブに移動します。トークンの右側にある  [Save Token] アイコン
（下矢印が付いた円形のアイコン）をク リ ッ ク し、トークンをローカル マシ
ンに保存します。

フ ィギュレーション ファイルのカスタマイズと署名

IEA トークン  ファ イルをダウンロードする と、コンフ ィギュレーシ ョ ン  
ファ イルをカスタマイズして署名できるよ うにな り ます。Cisco Registered 
Envelope Service（CRES）は、Cisco IronPort 暗号化テク ノ ロジーをサポー ト
2-7
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するホス ト  サービスです。プラグイン  コンフ ィギュレーシ ョ ン  ファ イルの
署名の検証は CRES システムによって行われるため、キー サーバと して 
IEA を使用しているユーザが Cisco IronPort Email Security Plug-in を導入す
る場合は、CRES の管理者アカウン ト も必要です。専用に作成された CRES 
管理者アカウン ト が必要な場合は、次の Cisco IronPort カスタマー サポート
にお問い合わせください：http://www.cisco.com/web/ironport/index.html

https://<IEA_hostname>/admin
http://www.cisco.com/web/ironport/index.html
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IEA キー サーバで使用する署名済みコンフ ィギュレーシ ョ ン  ファ イルを
作成するには、次の手順を実行します。

ステップ 1 CRES アカウン ト にログインします：https://res.cisco.com/admin 。管理コン
ソールが表示されます。

ステップ 2 [Accounts] タブに移動し、Email Security Plug-in を有効にするアカウン ト を
選択します。次に、[BCE Config] タブに移動します。

ステップ 3 トークン  タ イプと して  [IEA] を選択し、前に IEA からダウンロード した  
IEA トークンをアップロード します。

ステップ 4 [Download Template] をク リ ッ ク して、編集するテンプレー ト  ファ イルをダ
ウンロード します。ファ イル名は BCE_Config.xml です。

ステップ 5 コンフ ィギュレーシ ョ ン  ファ イルを編集します。

BCE_Config.xml ファ イルには、特定の環境に合わせて編集する必要がある
フ ィールドの詳細が含まれています。テキス ト  エディ タでファ イルを開
き、コ メ ン ト に記載されている手順に従って必要な変更を行います。

（注） ローカ リゼーシ ョ ンが目的の場合は、既存のメ ッセージ  セキュ リ テ ィ  ラベ
ル（Low、Medium、High）を変更しないでください。

ステップ 6 [Browse] をク リ ッ ク して、編集した BCE_Config.xml ファ イルを探し、ファ
イルが見つかったら  [Upload and Sign] をク リ ッ ク します。

コンフ ィギュレーシ ョ ン  ファ イルに署名する と、その署名したバージ ョ ン
が BCE_Config_signed.xml と してダウンロード されます。このファ イルを
ローカル マシンに保存します。

（注） IEA をキー サーバと して使用する場合は、BCE 設定タブ [Distribute Signed 
Configuration File to Bulk List]（オプシ ョ ン）で ステップ 5 を実行しないでく
ださい。このオプシ ョ ンは CRES にのみ適用され、今後の リ リースで削除さ
れる予定です。
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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ド  ユーザへのコンフ ィギュレーシ ョ ン  ファイルの

エン ド  ユーザにコンフ ィ ギュレーシ ョ ン  フ ァ イルを展開するには、IEA で
暗号化した電子メールによって、署名済みコンフ ィギュレーシ ョ ン  ファ イ
ルを各エン ド  ユーザに送信します。メ ッセージは、IEA と  CRES アカウン
ト で管理者と して示される電子メール アド レスから送信する必要があ り
ます。

（注） XML コンフ ィギュレーシ ョ ン  ファ イルが他のエンド  ユーザに転送された
場合は、管理者から受け取った場合とは異な り、自動設定が機能せず、エ
ラーが返されます。

（注） メーリ ング  リ ス ト宛てに BCE_Config_signed.xml ファ イルを送らないでく
ださい。CRES はメーリ ング  リ ス ト に対応していません。

BCE_Config_signed.xml ファ イルを使用して一括インス トールを実行する
には、BCE_Config.xml ファ イルを使用した一括インス トール（3-18 ページ）
を参照して ください。

o IronPort Email Security Plug-in の設定
Cisco IronPort Email Security Plug-in をインス トールする と、Outlook の 
[Cisco Email Security] タブから設定を変更できるよ うにな り ます。

• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] の順に移動します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] の順
2-9
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に移動します。

レポー ト  プラグインのインス トールまたは暗号化プラグインのインス
トールに変更を加える こ とができます。または、両方のプラグインのインス
トールに影響する汎用オプシ ョ ンを変更できます。たとえば、Cisco IronPort 
Email Security Encryption Plug-in のロギングを有効化または無効化した り、
特定の暗号化モードのオプシ ョ ンを変更する こ とができます。
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Cisc
TCP
暗号化する電子メールのマーキング方法を変更するには、BCE_Config.xml 
ファ イルを変更して、自動設定を実行する必要があ り ます。設定を指定する
場合、それらの設定は Cisco IronPort 暗号化アプラ イアンス と互換性がなけ
ればな り ません。

Outlook で設定を変更する場合は、第 4 章「Cisco IronPort Email Security 
Plug-in for Outlook の設定と使用」を参照して ください。

o IronPort Email Security Plug-in に必要な 
/IP サービス

Cisco IronPort Email Security Plug-in では、次の TCP/IP サービス と関連ポー
ト を使用する必要があ り ます。これらのポートは、TCP/IP サービスで使用
できる状態のままにしておく必要があ り ます。

• DNS（ド メ イン  ネーム  システム）。

DNS サービスは、インターネッ ト  ド メ イン名とホス ト名を  IP アド レス
に変換します。DNS は、Web ブラウザのアド レス  バーに入力された名
前を、それらのサイ ト をホス ト している  Web サーバの IPアド レスに自
動的に変換します。

ポー ト番号：53（TCP/UDP）

詳細については、次のサイ ト を参照して ください。
http://en.wikipedia.org/wiki/Domain_Name_System

影響：大

処置：このサービスは、すべてのエンド  ユーザに対してアクセス可能に
する必要があ り ます。

• SMTP（Simple Mail Transfer Protocol）

Simple Mail Transfer Protocol（SMTP）は、インターネッ ト  プロ ト コル
（IP）ネッ ト ワークを介して電子メール（E メール）を伝送するためのイ
ンターネッ ト標準です。
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OL-22158-03-J

ポート番号：25、587、465、475、2525（TCP）

詳細については、次のサイ ト を参照して ください。
http://en.wikipedia.org/wiki/Simple_Mail_Transfer_Protocol

影響：大
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処置：このサービスは、すべてのエンド  ユーザに対してアクセス可能に
する必要があ り ます。

• DHCP（ダイナ ミ ッ ク  ホス ト  コンフ ィギュレーシ ョ ン  プロ ト コル）

DHCP は、ネッ ト ワーク（ホス ト ）に接続するデバイスの設定に使用され
るネッ ト ワーク  プロ ト コルです。これによって、デバイスはインター
ネッ ト  プロ ト コル（IP）を使用してネッ ト ワーク上で通信できるよ うに
な り ます。

ポー ト番号：67、68（TCP/UDP）

詳細については、次のサイ ト を参照して ください。
http://en.wikipedia.org/wiki/Dynamic_Host_Configuration_Protocol

影響：大

処置：このサービスは、DHCP サーバから  IP アド レスを自動取得するエ
ンド  ユーザ全員に対してアクセス可能にする必要があ り ます。

• Net BIOS over TCP/IP

NetBIOS over TCP/IP（NBT または NetBT）は、NetBIOS API を利用して
いるレガシー コンピュータ  アプ リ ケーシ ョ ンで最新の TCP/IP ネッ ト
ワークを使用できるよ うにするネッ ト ワーク  プロ ト コルです。

ポー ト番号：137（UDP）（ネーム  サービス）、138（UDP）（データグラム  
サービス）、139（TCP）（セッシ ョ ン  サービス）

詳細については、次のサイ ト を参照して ください。
http://en.wikipedia.org/wiki/NetBIOS_over_TCP/IP

影響：大

処置：このサービスは、すべてのエンド  ユーザに対してアクセス可能に
する必要があ り ます。

• HTTP（Hypertext Transfer Protocol）

Hypertext Transfer Protocol（HTTP）は、コ ラボレーシ ョ ン  ハイパーメ
ディア分散情報システム用のアプ リ ケーシ ョ ン  プロ ト コルです。
2-11
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ポート番号：80、8080（TCP）

詳細については、次のサイ ト を参照して ください。
http://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol

影響：大

処置：このサービスは、すべてのエンド  ユーザに対してアクセス可能に
する必要があ り ます。
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• HTTPS（Hypertext Transfer Protocol Secure）

HTTPS は、コンピュータ  ネッ ト ワーク上で安全に通信するための通信
プロ ト コルであ り、特にインターネッ ト全体にわたって展開されてい
ます。

ポー ト番号：443（TCP）

詳細については、以下を参照して ください。
http://en.wikipedia.org/wiki/HTTP_Secure

影響：大

処置：このサービスは、すべてのエンド  ユーザに対してアクセス可能に
する必要があ り ます。

• IMAP（Internet Message Access Protocol）

Internet Message Access Protocol によって、電子メール ク ラ イアン トは
リ モー ト  メール サーバ上の電子メールにアクセスできます。

ポー ト番号：143、993（TCP）

詳細については、次のサイ ト を参照して ください。
http://en.wikipedia.org/wiki/Internet_Message_Access_Protocol

影響：大

処置：このサービスは、すべてのエンド  ユーザに対してアクセス可能に
する必要があ り ます。

• POP3（Post Office Protocol）

Post Office Protocol は、TCP/IP 接続を介して リモー ト  サーバから電子
メールを取得するために、電子メール ク ラ イアン ト によって使用され
ます。

ポー ト番号：110、995（TCP）

詳細については、次のサイ ト を参照して ください。
http://en.wikipedia.org/wiki/Post_Office_Protocol

影響：大
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処置：このサービスは、すべてのエンド  ユーザに対してアクセス可能に
する必要があ り ます。
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インストールの実行

では、複数のデスク ト ップに一括インス トールを実行する方法につ
明します。内容は次のとおりです。 

ンス トールの実行（3-1 ページ）

スタム  コンフ ィギュレーシ ョ ン  ファ イルの使用（3-15 ページ）

の実行
トールを実行するには、次の手順を実行して、ネッ ト ワーク共有フォ

配布パッケージ、新しいパッケージのウ ィザード、新しいプログラム
ザードを作成します。

トールを実行するには次の手順を実行します。

トール パッケージを含むネッ ト ワーク共有フォルダを作成し、ユー
して共有フォルダへのアクセス権限を付与します。

 管理ツールを開きます。
3-1
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3-2
ステップ 3 新しいソフ ト ウェア配布パッケージを作成します。

ステップ 4 パッケージの名前を入力し、[Next] をク リ ッ ク します。
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ステップ 5 ネッ ト ワーク共有フォルダへのパスを入力して、ステップ 1 で作成した
ネッ ト ワーク  ソース  ディ レ ク ト リ を指定します。 フォルダへのパスを入
力するか、フォルダを参照します。 [Next] をク リ ッ ク します。

ステップ 6 [New Package Wizard] で次のステップに進み、[Next] をク リ ッ ク します。 
3-3
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ステップ 7 [New Package Wizard] が正常に完了したこ とを確認して、[Close] をク リ ッ
ク します。
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド

OL-22158-03-J



OL-22

第 3 章      一括インストールの実行
ステップ 8 新しい分散ポイン ト を作成し、[Welcome] ページの [Next] をク リ ッ ク します。
3-5
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3-6
ステップ 9 新しい分散ポイン ト を選択します。 [New Distribution Points Wizard] で以降
のページをク リ ッ ク して、[Close] をク リ ッ ク します。
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ステップ 10 新しいプログラムを作成します。
3-7
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ステップ 11 コマン ド ラ イン  フ ィールドに、次のコマン ドを入力します。{共有のネッ ト
ワーク  パス}\Cisco IronPort Email Security Plug-in.exe /exenoui /qn

例：\\sc2007\Shared\Cisco IronPort Email Security Plug-in.exe /exenoui /qn 
\\sc2007\Shared\Cisco IronPort Email Security Plug-in.exe はネッ ト ワーク共
有フォルダ内の .exe ファ イルへのフル ネッ ト ワーク  パスです。

（注） カスタマイズされたコンフ ィギュレーシ ョ ン  ファ イルを使用する場合は、
カスタマイズされたファ イルをインス トールで使用できるよ うにする特別
なキーをこのステップで追加する必要があ り ます。 次の構文を使用して、コ
マンド ラ インから（ = 記号の後にカスタム  コンフ ィギュレーシ ョ ン  ファ イ
ルの場所を指定して）特別なキーを追加します。 
Cisco IronPort Email Security Plug-in.exe /exenoui /qn 
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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UseCustomConfig="\\sc2007\Shared\config\" 

コンフ ィギュレーシ ョ ン  ファ イルのカスタマイズの詳細については、カス
タム  コンフ ィギュレーシ ョ ン  ファ イルの使用（3-15 ページ）を参照して くだ
さい。
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ステップ 12 [Run] フ ィールドで [Hidden] を選択し、[Next] をク リ ッ ク します。

ステップ 13 要件ページをク リ ッ ク して、[Next] をク リ ッ ク します。

ステップ 14 次の環境オプシ ョ ンを選択します。 

• [Program can run]：ユーザのログイン時に限り ます。 実行モードに管理
者権限が設定されている場合は、 [Program can run]を  [Whenever the user 
is logged on] に設定できます。

• [Run mode]：ユーザの権限で実行するか、またはユーザが新しいソフ ト
ウェアのインス トールに必要な権限を持っていない場合は管理権限で
実行します。

ステップ 15 [New Program Wizard] が正常に完了したこ とを確認して、[Close] をク リ ッ
ク します。
3-9
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ステップ 16 新しいアドバタイズ メ ン ト を作成します。
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ステップ 17 名前を入力し、作成したパッケージとプログラムを選択します。 プラグイン
をインス トールするク ライアン トのグループが含まれる収集を選択して、
[Next] をク リ ッ ク します。
3-11
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ステップ 18 割り当てを必須と して設定します。 [Next] をク リ ッ ク します。

ステップ 19 ユーザ設定に基づいてスイ ッチを選択します。 少な く と も  1 つの必須割り
当てを設定する必要があ り ます。 [Do Not Run Program] を選択する と、接続
速度が遅い場合にプログラムが開始されないため、これを選択しないでく
ださい。 [Next] をク リ ッ ク します。

ステップ 20 [New Advertisement Wizard] をク リ ッ ク し、[Next] をク リ ッ ク します。
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ステップ 1 [New Advertisement Wizard] が正常に完了したこ と示す確認を表示して、
[Close] をク リ ッ ク します。
3-13
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ステップ 2 [Advertisement Status] ウ ィ ン ド ウで [Advertisement Status] を表示します。

ステップ 3 アドバタイズ メ ン ト  レポート を作成して詳細を表示するには、コンテキス
ト  メニューで [Show message] > [All] を選択します。 エラーが発生した場合
は、レポート を調べてエラーが発生した場所を確認できます。
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カス
使用

概要
タム コンフ ィギュレーショ ン ファイルの

Cisco IronPort Email Security Plug-in では、インス トールに含まれている一連
の XML ファ イルを編集する こ とで、デフォル ト設定を変更できます。 別の
コンフ ィギュレーシ ョ ン  ファ イルを使用して、インス トールの設定を変更
する こ と もできます。 たとえば、暗号化コンフ ィギュレーシ ョ ン  ファ イル
でファ イルにフラグを付ける方法を変更できます（この変更は、暗号化アプ
ラ イアンスでも この方法を変更できる場合に限り行います）。 また、レポー
ト  コンフ ィギュレーシ ョ ン  ファ イルで、報告用の最大メール サイズ、報告
後にファ イルのコピーを保持するかど うかなどのデフォル ト  オプシ ョ ン
の一部を変更できます。 ボタン名をカスタマイズする こ と、さ らに、ユーザ 
インターフェイスで使用されているテキス ト をローカラ イズする こ と もで
きます。 

カスタム  コンフ ィギュレーシ ョ ン  ファ イルを変更および展開するには、次
の手順を完了します。

ステップ 1 \\%allusersprofile%\Cisco\Cisco IronPort Email Security Plug-In\ ディ レク
ト リ のコピーを作成します。 Common フォルダを含める必要があ り ます。 

（注） 正当性を維持するため、元のファ イルのディ レク ト リ構造を維持する必要
があ り ます。 Cisco IronPort Email Security プラグインのディ レク ト リ で始ま
る構造を維持している こ と、コンフ ィギュレーシ ョ ン  ファ イルと一緒にす
べてのファ イルを含めたこ とを確認します。

ステップ 2 XML コンフ ィギュレーシ ョ ン  ファ イルを編集します。 新しいファ イルを
3-15
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作成する代わりに、インス トール ファ イルに含まれた XML ファ イルを変
更する こ と をお勧めします。 これらのファ イルを変更する方法について
は、XML コンフ ィギュレーシ ョ ン  ファ イルの編集（3-16 ページ）を参照し
て ください。
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XML
ステップ 3 インス トールの実行（3-1 ページ）に説明されている方法で一括インス トール
を実行し、カスタム  コンフ ィギュレーシ ョ ン ファ イルの展開（3-19 ページ）
に説明されている方法でカスタマイズされた XML ファ イルを展開します。

 コンフ ィギュレーション ファイルの編集

Cisco IronPort Email Security Plug-in をインス トールする と、構成データが作
成されて XML ファ イルに保存されます。 文字列型の値を編集して、パラ
メータ値をカスタマイズする こ とができます。 ただし、値を削除する こ と
や、ファ イルの構造を変更する こ とはお勧めしません。

デフォル ト では、プラグインによ り、Outlook の次の場所にある  
%AllUsersProfile% ディ レク ト リ にコンフ ィギュレーシ ョ ン  ファ イルがイ
ンス トールされます。

%allusersprofile%\Cisco\Cisco IronPort Email Security Plug In

XML ファ イルは、次のデフォル ト の場所に配置されます。

• \\%allusersprofile%\Cisco\Cisco IronPort Email Security 
Plug-In\Common\CommonEncryptionConfig.xml：Desktop Encryption プ
ラグインに関連する構成データが含まれます。

• \\%allusersprofile%\Cisco\Cisco IronPort Email Security 
Plug-In\Common\config_1.xml, config_{N}.xml：この番号はユーザ アカ
ウン ト の数によって異な り ます。

• \\%allusersprofile%\Cisco\Cisco IronPort Email Security 
Plug-In\Common\CommonConfig.xml：ログ  ファ イルの場所や、ローカ
リ ゼーシ ョ ン  ファ イルの名前（デフォル ト のローカ リ ゼーシ ョ ン  ファ
イルは en-US.xml）など、レポー ト  プラグイン と暗号化プラグインの両
方に共通する基本的な構成データが含まれます。 電子メール プログラ
ムの設定情報を使用してログ  フ ァ イルの場所を変更し、一括インス
トール プログラム と一緒にその設定情報を展開できます。 使用可能な
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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ローカ リ ゼーシ ョ ン  ファ イルとは異なる言語でローカ リ ゼーシ ョ ン  
ファ イルを作成する場合は、新しい XML フ ァ イルの名前をこ こで参
照する必要があ り ます。 

• \\%allusersprofile%\Cisco\Cisco IronPort Email Security 
Plug-In\Common\Reporting.xml：報告可能な最大メール サイズなど、
Reporting Plug-in に関連する設定データが保存されます。 このファ イル
を変更する こ とはお勧めしません。 
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例

• \\%allusersprofile%\Cisco\Cisco IronPort Email Security 
Plug-In\Common\Localization\en-US.xml：ローカル言語に関連する
データが含まれます。 デフォル ト の言語は英語です。 ただし、de.xml、
es.xml、fr.xml、it.xml、zh-CN.xml を含め、いくつかのローカ リゼーシ ョ ン  
ファ イルが使用可能です。 これらの xml ファ イルの対象ではない言語
を使用する場合は、カスタム  xml ファ イルを作成し、そのファ イルを  
CommonConfig.xml ファ イルの中で参照できます。 

警告 <または > 記号の内側にあるどの文字列 ID も変更しないで く ださ
い。変更すると、プラグインが正し く機能しな く なります。 

次の例は、en-US.xml ファ イルに変更を加える例を示しています。

レポー ト  ツールバー内のテキス ト を変更するには、en-US.xml とい う  
xml ファ イルの次のセクシ ョ ンを参照し、太字で表記されているテキス
ト を編集します。

<group name="Mso.Report.Button.Cations">
 <string id="blockSender">Block Sender</string> 
 <string id="spam">Spam</string> 
 <string id="ham">Not Spam</string> 
 <string id="virus">Virus</string> 
 <string id="phish">Phish</string> 
</group>

タ イ トルに説明を追加する場合は、たとえば、次のよ うにテキス ト を変
更できます。

<group name="Mso.Report.Button.Cations">

 <string id="blockSender">Outlook を使用して送信者をブロ ッ ク</string> 
 <string id="spam">スパムと してレポート </string> 
 <string id="ham">スパムでないとレポート </string> 
 <string id="virus">ウイルス と してレポート </string> 
 <string id="phish">フ ィ ッシング攻撃と してレポート </string> 
3-17
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BCE
_Config.xml ファイルを使用した一括インストール

BCE_Config.xml ファ イルを使用して一括インス トールを行うには、次の手
順を実行します。

ステップ 1 \\%allusersprofile%\Cisco\Cisco IronPort Email Security Plug-In\Common 
ディ レク ト リ に移動します。 

ステップ 2 config_1.xml file があれば、これを削除します。

ステップ 3 BCE_Config_signed.xml ファ イルをこのディ レク ト リ にコピーして、ファ イ
ル名を  config_1.xml に変更します。

ステップ 4 \\%allusersprofile%\Cisco\Cisco IronPort Email Security 
Plug-In\CommonEncryptionConfig.xml ファ イルに移動します。 

ステップ 5 CommonEncryptionConfig.xml ファ イルに次のタグが含まれている こ と を確
認します。

 <accountFileNames>
    <accountFileName filePath="config_1.xml" emailAddress="*" />
  </accountFileNames>

（注） 特定のド メ イン内の選択されたユーザだけを設定するには、そのド メ イン
を電子メール アド レス と して指定して、CommonEncryptionConfig.xml ファ
イルを変更する必要があ り ます。

たとえば、シスコのユーザだけに BCE コンフ ィギュレーシ ョ ン  ファ イルを
適用するには、次のよ うに変更します。

<accountFileName filePath="config_1.xml" emailAddress="*" /> 

が、次のよ うに変わり ます。

<accountFileName filePath="config_1.xml" emailAddress="@cisco.com" />

accountFileName タグを複数指定する場合は、filePath を  config_2.xml, 
config_3.xml など と します。
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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次に例を示します。

<accountFileName filePath="config_2.xml" emailAddress="@cisco.com" />
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カス
ステップ 6 インス トールの実行（3-1 ページ）に説明されている方法で一括インス トール
を実行し、カスタム  コンフ ィギュレーシ ョ ン ファ イルの展開（3-19 ページ）
に説明されている方法でカスタマイズされた XML ファ イルを展開します。

（注） \\%allusersprofile%\Cisco\Cisco IronPort Email Security Plug-In\Common 
ディ レク ト リ の内容を  \\{SHARED_DIR}\{CONFIG_FOLDER} にコピー
する必要があ り ます。 {CONFIG_FOLDER} に Common フォルダが存在し
ている必要があ り ます。 UseCustomConfig コマン ド  パラ メータによ り、変更
したカスタム  コンフ ィギュレーシ ョ ン  ファ イルをインス トールで使用で
きるよ うにな り ます。

タム コンフ ィギュレーション ファイルの展開

コンフ ィギュレーシ ョ ン  ファ イルの編集が完了した後、展開時に特別な
キーを追加し、変更後のカスタム  コンフ ィギュレーシ ョ ン  ファ イルがイン
ス トーラによって使用されるよ うにする必要があ り ます。 
UseCustomConfig コマン ド  ラ イン  パラ メータを使用する と、インス トール
でカスタム  コンフ ィギュレーシ ョ ン  ファ イルを使用し、インス トール時に
使用する必要のあるコンフ ィギュレーシ ョ ン  ファ イルを格納している
フォルダへのパスを指定できます。

一括インス トールのステップ 11 で、次の構文を使用してコマン ド  ラ イン
から  UseCustomConfig キーを追加（インス トールの実行（3-1 ページ）を参
照）します。

Cisco IronPort Email Security Plugin.exe /exenoui /qn
UseCustomConfigs="\\{SHARED_DIR}\{CONFIG_FOLDER}

= の後に、カスタマイズされたコンフ ィギュレーシ ョ ン  ファ イルへのパス
を指定します。
3-19
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その他のコマンド

UseCustomConfig 以外に、次のコマン ドを使用できます。

• AppDir="C:\CustomInstallDir"：カスタム  ターゲッ ト  ディ レク ト リ を指
定します。

• SkipReporting="TRUE"：次のインス トールのレポート  プラグインを無
効にします。

• SkipEncryption="TRUE"：次のインス トールの暗号化プラグインを無効
にします。
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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CH A P T E R 4
co IronPort Email Security Plug-in 
 Outlook の設定と使用

では、Cisco IronPort Email Security Plug-in for Outlook で使用可能な機
いて説明します。Cisco IronPort Email Security Plug-in には、Outlook 
ール プログラム と連動する数種類のセキュ リ テ ィ  プラグインが用
ています。この章の内容は、次のとおりです。

isco IronPort Email Security Plug-in For Outlook の全般的な設定
-2 ページ）

utlook プラグインの基本設定（4-3 ページ）

要な電子メールによるスパム、ウ イルス、およびフ ィ ッシング攻撃の
告（4-4 ページ）

子メールの暗号化（4-10 ページ）

lag およびデスク ト ップ暗号化の設定（4-12 ページ）

lag 暗号化（4-14 ページ）

ス ク ト ップ暗号化（4-21 ページ）

号化されたセキュア  メ ッセージを初めて開封する場合（4-45 ページ）

グ設定の変更（4-50 ページ）
4-1
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ラーおよび ト ラブルシューテ ィ ング（4-52 ページ）

断ツールを使用した ト ラブルシューテ ィ ング（4-58 ページ）

isco IronPort Email Security Plug-in のアンインス トール（4-61 ページ）



第 4 章      Cisco IronPort Email Security Plug-in for Outlook の設定と使用

4-2

Cisc
全般

Enab
o IronPort Email Security Plug-in For Outlook の
的な設定

Cisco IronPort Email Security Plug-in は、暗号化プラグインやレポート  プラ
グインなど、複数の Cisco プラグインをサポートするプラ ッ ト フォームで
す。Cisco IronPort Email Security Plug-in の一般的な設定は [Options] ページ
から行う こ とができます。

le または Disable
デフォル ト では、Cisco IronPort Email Security Plug-in はインス トール時に有
効にな り ます。Cisco IronPort Email Security Plug-in は次の場所から無効化で
きます。

• Outlook 2010 では、[File] > [Options] に移動し、左側のナビゲーシ ョ ン  
バーから  [Add-ins] を選択します。次に、ページの下部にある  [Manage] 
ド ロ ップダウン  メニューから  [COM Add-ins] を選択し、[Go...] をク
リ ッ ク します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] の順
に移動します。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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[COM Add-Ins] ウ ィ ン ド ウで、Cisco IronPort Email Security Plug-in のチェ ッ
クボッ ク スをオフにして  [OK] をク リ ッ ク します。
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Out
look プラグインの基本設定
エンド  ユーザは [Cisco Email Security] タブで基本的な設定項目を設定でき
ます。

• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] の順に移動します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] の順
に移動します。

[Cisco Email Security] タブ
4-3
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エンド  ユーザは、このタブで [Enable] チェ ッ クボッ ク スをオンにする こ と
によ り、暗号化、レポート 、ロギングを有効にできます。さ らに設定を行うに
は、[Encryption Options...]、[Reporting Options...]、または [Logging Options...] 
ボタンをク リ ッ ク します。エン ド  ユーザは、問題解決時に診断ツールを使
用し、Cisco IronPort Email Security Plug-in でレポート を実行してシスコのサ
ポート に送信する こ と もできます。
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不要
およ

レポ
な電子メールによるスパム、ウイルス、
びフ ィ ッシング攻撃の報告

レポート  プラグインを使用する と、エン ド  ユーザは、受信した電子メール
がスパム、フ ィ ッシング攻撃、またはウイルスであった場合にシスコに報告
できます。また、誤ってスパム と分類されたメールについても報告できます
（「ハム」と も呼ばれます）。

Cisco IronPort Email Security Reporting Plug-in for Outlook は、Outlook の 
[Options] ページを使用して設定できます。レポー ト を有効にするには、次の
手順を実行します。

• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] の順に移動します。[Cisco Email Security] タブで、
[Reporting] フ ィールドの [Enable] チェ ッ クボッ ク スをオンにします。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] タブ
の順に移動します。[Cisco Email Security] タブで、[Reporting] フ ィール
ドの [Enable] チェ ッ クボッ ク スをオンにします。

ート  オプショ ン

レポート の設定は [Cisco Email Security] ページにあ り ます。レポー ト の設
定を変更するには、次の手順を実行します。

• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] の順に移動し、[Reporting Options] ボタンをク リ ッ
ク します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] タブ
の順に移動し、[Reporting Options] ボタンをク リ ッ ク します。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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オプ
[Reporting Options] ページ：

ション

こ こでは、エン ド  ユーザが設定できるレポート  オプシ ョ ンについて説明し
ます。

オプシ ョ ン  説明

Keep a copy of sent report デフォル ト では、スパムまたはウイ
ルスの電子メール メ ッセージ、ある
いは誤ってスパムまたはウイルス
である と分類された電子メール 
メ ッセージについて、エン ド  ユーザ
がシスコに報告した場合、その送信
された報告電子メールは削除され
ます。このオプシ ョ ンを選択する
と、電子メールは削除されません。

Display notification when an email 
is successfully reported

1 件の電子メールがスパムやウイル
ス と して正常に報告された場合に、
成功を示すメ ッセージを  Outlook の
4-5
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ダイアログボッ クスに表示できま
す。このオプシ ョ ンをオフにする
と、このダイアログボッ クスは表示
されません。
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Display notification when multiple 
emails are successfully reported

一連の電子メールがスパムやウイ
ルス と して正常に報告された場合
に、成功を示すメ ッセージを  
Outlook のダイアログボッ ク スに表
示できます。このオプシ ョ ンをオフ
にする と、このダイアログボッ クス
は表示されません。

Add security toolbar to main 
window

デフォル ト では、エン ド  ユーザが 
Cisco IronPort Email Security Plug-in 
をインス トールする と、Outlook の
メ イン  ウ ィ ン ド ウにプラグイン  
ツールバーが追加されます。このオ
プシ ョ ンをオフにする と、このツー
ルバーは Outlook のメ イン  ウ ィ ン
ド ウに追加されません。

Add message reporting options to 
right-click menu

デフォル ト では、Cisco IronPort 
Email Security Plug-in をインス トー
ルする と、Outlook の右ク リ ッ ク  コ
ンテキス ト  メニューにレポー ト  プ
ラグインのメニュー項目が追加さ
れます。このオプシ ョ ンをオフにす
る と、このメニュー項目は右ク リ ッ
ク  コンテキス ト  メニューに追加さ
れません。

Add security toolbar to message 
window

デフォル ト では、エン ド  ユーザが 
Cisco IronPort Email Security Plug-in 
をインス トールする と、電子メール 
メ ッセージ ウ ィ ン ド ウにプラグイ
ン  ツールバーが追加されます。この
オプシ ョ ンをオフにする と、ツール
バーは電子メール メ ッセージ ウ ィ

オプシ ョ ン  説明
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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ン ド ウに追加されません。
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Repo

概要

シス
rting Plug-in for Outlook の使用方法

Cisco IronPort Email Security Plug-in for Outlook では、エン ド  ユーザは、受信
ト レイで受信したスパム、ウ イルス、フ ィ ッシングのメールについてシスコ
にフ ィードバッ クを送信できます。たとえば、誤分類された場合やスパム と
して扱うべき場合に、それらの電子メール メ ッセージについてシスコに報
告できます。シスコでは、このフ ィードバッ クを活用して、不要なメ ッセー
ジが受信ボッ クスに配信されないよ うにフ ィルタを更新します。

このプラグインをインス トールする と、Outlook のメニュー バーと右ク
リ ッ ク  メ ッセージ メニューに便利なインターフェイスが追加されます。こ
のインターフェイスを使用して、スパム、ウ イルス、フ ィ ッシングの電子
メールや、誤分類された電子メールを報告する こ とができます。電子メール
を報告する と、レポー ト が送信されたこ とを示すメ ッセージが表示されま
す。エン ド  ユーザが報告したメ ッセージは、シスコの電子メール フ ィルタ
の強化に使用されます。これによって、受信ト レイに一方的に送りつけられ
る メールの全体量が減少します。

コへのフ ィードバック

このプラグインをインス トールする と、Outlook に新たにツールバーが追加
されます。このツールバーには、[Spam]、[Not Spam]、[Virus]、[Phish]、[Block 
Sender] ボタンが含まれています（[Block Sender] はエンド  ユーザの迷惑
メール ボッ ク スに届く電子メールをブロ ッ ク しません）。
4-7
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これらのボタンを使用して、スパム、ウ イルス、フ ィ ッシングのメールを報
告します（フ ィ ッシング攻撃とは、「不正な」偽装 Web サイ ト に リ ンク して
いる電子メールを送りつける攻撃です。これらの Web サイ トは、クレジッ
ト  カード番号、口座の名義人名とパスワード、社会保障番号など、個人の金
融情報を受信者に漏洩させる こ と を目的と しています。たとえば、個人の銀
行口座情報を不正に要求する電子メールが infos@paypals.com から送信さ
れて く る こ とがあ り ます）。さ らに、エン ド  ユーザは [Block Sender] ボタン
をク リ ッ クする こ と もできます。このボタンをク リ ッ クする と、Outlook の
迷惑メール対策アクシ ョ ンである  「送信者を受信拒否リ ス ト に追加」する
機能が作動します。この機能の詳細については、Microsoft のドキュ メ ン ト
を参照して ください。

また、右ク リ ッ ク  コンテキス ト  メニューを使用して、スパム、誤分類された
メール、ウイルス、フ ィ ッシングを報告する こ と もできます。

さ らに、メ ッセージ ウ ィ ン ド ウのボタンを使用して、スパム、ウ イルス、
フ ィ ッシング、誤分類されたメールを報告できます（誤分類されたメールと
は、誤ってスパム、ウ イルス、またはフ ィ ッシングと してマーク されたメー
ルです）。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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スパム
、ウイルス、フ ィ ッシングとして報告された電子メールのメ ッセージ処理の流れ

スパム、誤分類、ウイルス、フ ィ ッシングと して電子メール メ ッセージが報
告された場合、そのメ ッセージは次のよ うに処理されます。

受信ト レイのメ ッセージ： 

• スパム、ウ イルス、またはフ ィ ッシングと して報告された受信ト レイの
メ ッセージは、[Junk Email] フォルダに移動されます。

• 「非スパム」と報告された受信ト レイのメ ッセージは、[受信ト レイ ] フォ
ルダに残されます。

迷惑メ ッセージ：

• スパム、ウ イルス、またはフ ィ ッシングと して報告された迷惑メ ッセー
ジは、[Junk Email] フォルダに残されます。

• 「非スパム」と報告された迷惑メ ッセージは、[受信ト レイ ] フォルダに移
動されます。

受信した電子メールがスパム と誤分類された場合（つま り、フ ィルタ リ ング
され、[Junk Email] フォルダに送られた場合）は、[Not Spam] ボタンをク リ ッ
ク して、電子メールが誤分類されたこ とを報告できます。これによ り、今後
この送信者からのメールはスパム と して分類されないよ うにな り ます。

エン ド  ユーザは、右ク リ ッ ク  コンテキス ト  メニューを使用して、誤分類さ
れたメールにマークを付ける こ と もできます。
4-9
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電子
メールの暗号化
暗号化プラグインを使用する と、エン ド  ユーザは企業ネッ ト ワークの外部
に電子メールを送信する前に、デスク ト ップから メールを暗号化した り、暗
号化が必要な電子メールにフラグを設定する こ とができます。次のいずれ
かの暗号化オプシ ョ ンを選択します。

• Flag 暗号化。Flag 暗号化オプシ ョ ンを使用する と、暗号化が必要な電子
メールにフラグを設定できます。この電子メールは、Cisco IronPort 暗号化
アプライアンスによって暗号化されてから、ネッ ト ワークの外部に送信
されます。Flag 暗号化は、エンド  ユーザが組織外に送信する メールを暗
号化する必要があ り、組織内で送信する メールの暗号化を必要と しない
場合に使用できます。たとえば、機密の医療文書を扱っている組織では、
患者に送信する前にそれらの文書を暗号化する必要があ り ます。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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• デスク ト ップ暗号化。デスク ト ップ暗号化では、Cisco IronPort 暗号化テ
ク ノ ロジーを使用して  Outlook 内から電子メールを暗号化できます。そ
の後、暗号化された電子メールがデスク ト ップから送信されます。デス
ク ト ップ暗号化は、エン ド  ユーザが組織内で送信する メールを暗号化
する必要がある場合に使用できます。たとえば、組織内と組織外の両方
の送信において、すべての機密財務データを暗号化する必要がある場
合などです。
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図 4-1 Flag 暗号化とデスク ト ップ暗号化のワークフロー 

注 暗号化の方式は、Outlook 電子メール アカウン ト からの 
BCE_Config_signed.xml 添付ファ イルを復号化する こ とによって決ま り ま
す。デフォル ト では、Decrypt Only モードが有効にな り ます。エン ド  ユーザ
は、管理者から更新済みの BCE_Config_signed.xml ファ イルを受信して復号
化する こ とによって暗号化方式を変更できるよ うに、インス トールを変更
できます。

Cisco IronPort Email Security 
Plug-in を使用して、電子メール 
ク ライアン トがキー要求を送信

暗号化された
メ ッセージ

暗号化対象と して
フラグが設定され
た メ ッセージ

暗号化サーバ

Flag
暗号化

デスク
ト ップ
暗号化

Exchange 
Server

Exchange 
Server

暗号化アプラ イ
アンスがキー要
求を送信

暗号化アプラ イア
ンスが暗号化メ ッ
セージを渡す

**存在しない場合もあ り
ます。

暗号化サーバ

Cisco IronPort Email 
Security Plug-in を使
用する電子メール ク
ラ イアン ト
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Flag

Ema
の起
 およびデスク ト ップ暗号化の設定
エンド  ユーザの Outlook 電子メール アカウン トのデフォルトのコンフ ィ
ギュレーシ ョ ン  モードは、Decrypt Only です。フラグまたは暗号化機能を有効
にするには、更新済みの添付ファイルを管理者から受け取り、それを使用し
てエンド  ユーザの電子メール アカウン ト を設定します。また、フラグおよび
暗号化機能は一括インス トールによって有効化できます。一括インス トール
では、一連のコンフ ィギュレーシ ョ ン ファ イルがユーザの設定フォルダに直
接配布されます。復号化したメ ッセージに BCE_Config_signed.xml 添付ファイ
ルが含まれている場合は、エンド  ユーザがそのコンフ ィギュレーシ ョ ン  
ファ イルを起動する と、Encryption Plug-in for Outlook が自動的に設定されま
す。Cisco IronPort 暗号化アプライアンスまたは Cisco Registered Envelope 
Service（CRES）は、キー サーバと して使用されます。エンド  ユーザがアカウ
ン ト を持っていない場合は、登録を求めるプロンプ トが表示されます。

次の 3 つのコンフ ィギュレーシ ョ ン  モードを利用できます。

• Decrypt Only：受信した暗号化電子メールを復号化できます。

• Decrypt and Flag：安全な電子メール メ ッセージの復号化とフラグ設定
を行う こ とができます。フラグ  オプシ ョ ンを使用する と、エン ド  ユーザ
は暗号化が必要な電子メールにフラグを設定できます。この電子メー
ルは、Cisco 電子メール セキュ リ テ ィ  アプラ イアンスによって暗号化
されてから、ネッ ト ワークの外部に送信されます。フラグが設定された
メ ッセージを検出してサーバで復号化できるよ うサーバの設定を行う
必要があ り ます。

• Decrypt and Encrypt：安全な電子メール メ ッセージの暗号化と復号化
を行う こ とができます。

il Security Plug-in のコンフ ィギュレーション ファイル
動

エンド  ユーザは、Outlook 電子メール アカウン ト からの 
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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BCE_Config_signed.xml 添付ファ イルを復号化する こ とによって、Outlook 
電子メール アカウン ト の暗号化を有効化した り設定する こ とができます。
エン ド  ユーザの受信ト レイに添付ファ イル付きの通知メールがない場合
は、スパム  メールまたは迷惑メールのフォルダを調べて ください。
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コンフ ィギュレーシ ョ ン  ファ イルを起動する と、BCE_Config_signed.xml 添
付ファ イル付きの通知メ ッセージを受信した電子メール アカウン ト にプ
ラグインが設定されます。

注 通常は、プラグインのインス トール時に Jave Runtime Environment（JRE）が
自動的にインス トールされます。インス トールされなかった場合は、最新の
バージ ョ ン  1.6 をインス トールしてプラグインで使用して ください。

Outlook 電子メール アカウン ト に対してセキュ リ テ ィ  プラグインを有効化
して設定するには、次の手順を実行します。

ステップ 1 BCE_Config_signed.xml ファ イルが添付された通知メール メ ッセージを開
きます。設定の適用について確認を求める メ ッセージが表示されます。
4-13
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Flag
ステップ 2 [Yes] をク リ ッ ク して、Cisco IronPort Email Security Plug-in を設定します。設
定が正常に適用される と、メ ッセージが表示されます。

 暗号化
Flag 暗号化オプシ ョ ンを使用する と、エン ド  ユーザは暗号化が必要な電子
メールにフラグを設定できます。この電子メールは、Cisco IronPort 暗号化ア
プラ イアンスまたは電子メール セキュ リ テ ィ  アプラ イアンスによって暗
号化されてから、ネッ ト ワークの外部に送信されます。社内ネッ ト ワークか
ら外部に発信される メールに対してスパムやウイルスのスキャンが必要な
場合は、Flag 暗号化方式を使用する必要があ り ます。

Flag 暗号化の設定は [Cisco Email Security] ページにあ り ます。Flag 暗号化
の設定を変更するには、次の手順を実行します。

• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] > [Encryption Options] の順に移動します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] > 
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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[Encryption Options] の順に移動します。

暗号化プラグインを有効化または無効化するには、[Cisco Email Security] タ
ブで [Encryption] フ ィールドの [Enable] チェ ッ クボッ ク スをオンまたはオ
フにします。

[Enable] をオンにする と、電子メール プログラムからセキュア  エンベロー
プで機密メールを送信できます。
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Flag

暗号化
Cisco Email Security の [Add-in Options] ページ：

 暗号化のオプショ ン

アカウン ト

[Encryption Accounts] ページには、Flag 暗号化プラグインの対象となるすべ
ての電子メール ユーザ アカウン ト が表示されます。各行は 1 つのアカウン
4-15
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ト に対応しており、アカウン ト の電子メール アド レス と暗号化タイプが表
示されます。[Options] をク リ ッ クするか、アカウン ト  アド レスをダブルク
リ ッ クする と、[Encryption Options] ページが開きます。
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Flag 暗
[Encryption Accounts] ページ：

 

注 Outlook の新規アカウン トは [Encryption Accounts] リ ス ト に自動的に追加
されます。Outlook アカウン ト が削除される と、そのアカウン トは 
[Encryption Accounts] リ ス ト から自動的に削除されます。

号化された電子メールの送信オプショ ン

エンド  ユーザが送信メールの暗号化を必要と している場合、管理者はその
電子メールに暗号化のマーク（「フラグ」）を設定する必要があ り ます。これ
によ り、管理者が作成したフ ィルタを使って暗号化が必要なメ ッセージを
識別できます。

注 暗号化が必要な電子メールにフラグを設定する この暗号化方式では、正し
く機能するよ うに電子メール フ ィルタを変更する必要があ り ますが、この
変更は管理者だけが実行できます。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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[Encrypt Message] ボタンは、電子メールの作成時に使用できます。次のいず
れかの方法で電子メールに暗号化のマークを設定できます。
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[Gener
al] タブ

次の図は、[Flag Encryption Options] の [General] タブを示しています。

次の [General] のオプシ ョ ンから選択できます。

[General] のオプシ ョ ン 値

Flag Subject Text 送信メールの [Subject] フ ィールドにテキ
ス ト を追加して、電子メールに暗号化のフ
ラグを付ける こ とができます。[Subject] 
フ ィールドに追加するテキス ト を入力し
て、電子メールを暗号化する必要がある こ
と を示します（デフォル ト値は [SEND 
SECURE]）。
4-17
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[Conne
ction] タブ

次の図は、[Flag Encryption Options] の [Connection] タブを示しています。

Flag X-header name/value 送信メールに x ヘッダーを追加して、電子
メールに暗号化のフラグを付ける こ とが
できます。1 つめのフ ィールドに x ヘッ
ダーを入力します（デフォル ト値は 
x-ironport-encrypt です）。2 つめのフ ィール
ドに true または false を入力します。「true」
を入力する と、指定した  x ヘッダーが付い
たメ ッセージが暗号化されます（デフォル
ト値は「true」）。

Flag messages using Sensitivity 
header

Outlook では、秘密度に関するヘッダーを追
加して電子メールの暗号化を示すフラグを
メ ッセージに付ける こ とができます。この
方法を選択する と、Outlook の秘密度に関す
るヘッダーを使用して電子メールに暗号化
のマークを付ける こ とができます。

[General] のオプシ ョ ン 値
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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次の [Connection] のオプシ ョ ンから選択できます。

[Connection] のオプシ ョ ン 値

No proxy プロキシを使用しない場合に選択します。

Use system proxy settings デフォル ト のシステム  プロキシ設定を使
用する場合に選択します。

Manual proxy configuration 特定のプロキシの設定を入力する場合に
選択します。

Protocol デフォル ト の接続設定を使用しないこ と
を選択した場合は、[HTTP]、[SOCKS4]、
[SOCKS4a]、[SOCKS5] のいずれかのプロ
ト コルを選択します。

Host システムまたはプロキシ  サーバのホス ト
名または IP アド レスを指定します。

Port システムまたはプロキシ  サーバのポート
を指定します。

Username サーバでユーザ名が必要な場合に、ユーザ
名を入力します。

Password システムまたはプロキシ  サーバに対して
入力したユーザ名に関連するパスワード
を入力します。
4-19
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[Remem
ber Password] タブ

次の図は、[Flag Encryption Options] の [Remember password] タブを示してい
ます。

次の [Remember Password] のオプシ ョ ンから選択します。

パスワードのオプシ ョ ン 値

Never このオプシ ョ ンを選択する と、電子メール
を復号化または暗号化する と きに、常に暗
号化パスワードが必要にな り ます。

Always このオプシ ョ ンを選択する と、最初に電子
メールを復号化または暗号化する と きに
のみ、暗号化パスワードが必要にな り ま
す。パスワードはキャ ッシュ されます。

Minutes 暗号化パスワードがキャ ッシュ されるよ う
にするには、このオプシ ョ ンをオンにしま
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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す。パスワードを思い出すまでの分数を入
力するか、矢印を使用して分数を変更しま
す。指定した時間が経過する と、エンド  
ユーザは、暗号化された電子メールを復号
化する際に暗号化パスワードの再入力が必
要にな り ます。デフォル トは 1440 分です。
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デス
ク ト ップ暗号化 
デスク ト ップ暗号化オプシ ョ ンでは、Outlook 内から電子メールを暗号化
し、それをデスク ト ップから送信できます。

デスク ト ップ暗号化の設定は [Cisco Email Security] ページにあ り ます。デ
スク ト ップ暗号化の設定を変更するには、次の手順を実行します。

• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] > [Encryption Options] の順に移動します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] > 
[Encryption Options] の順に移動します。

エン ド  ユーザは、[Cisco Email Security] タブで [Encryption] フ ィールドの 
[Enable] チェ ッ クボッ ク スをオンまたはオフにする こ とで、暗号化プラグ
インを有効化または無効化できます。[Enable] をオンにする と、電子メール 
プログラムからセキュア エンベロープで機密メールを送信できます。

注 エンド  ユーザは [Cisco Email Security] ページから暗号化プラグインを有効
化/無効化できますが、暗号化モードに対する変更は、管理者が 
BCE_config.xml ファ イルを使って行う必要があ り ます。
4-21
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デス

暗号化
Cisco Email Security の [Add-in Options] ページ：

ク ト ップ暗号化のオプション

アカウン ト

[Encryption Accounts] ページには、デスク ト ップ暗号化プラグインの対象と
なるすべての電子メール ユーザ アカウン ト が表示されます。各行は 1 つの
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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アカウン ト に対応しており、アカウン ト の電子メール アド レス と暗号化タ
イプが表示されます。[Options] をク リ ッ クするか、アカウン ト  アド レスを
ダブルク リ ッ クする と、[Encryption Options] ページが開きます。
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[Gener
[Encryption Accounts] ページ：

注 Outlook の新規アカウン トは [Encryption Accounts] リ ス ト に自動的に追加
されます。Outlook アカウン ト が削除される と、そのアカウン トは 
[Encryption Accounts] リ ス ト から自動的に削除されます。

al] タブ

次の図は、[Desktop Encryption Options] の [General] タブを示しています。

注 ス ク リーンシ ョ ッ ト と表には [General] タブの使用可能なオプシ ョ ンがす
べて示されていますが、表示されるオプシ ョ ンは BCE_config.xml ファ イル
の設定に応じて異な り ます。
4-23
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次の [General] のオプシ ョ ンから選択します。

[General] のオプシ ョ ン 値

Server URL 暗号化サーバの URL を入力します。

Token File Name トークンは、電子メール ク ラ イアン ト と暗
号化サーバ間でデータを暗号化するため
に使用されるカスタマー固有のキーです。
現在、この情報はカスタマー サポート での
み使用され、変更できません。

Default Expiration (days) 暗号化された電子メールが有効な日数を
指定します。有効期間の日数が経過する と
メ ッセージは期限切れとな り、以降、受信
者はそのメ ッセージを開く こ とができな
く な り ます。

Default read-by (days) 受信者が暗号化されたメ ッセージを読むと
予想される期間を日数で指定します。指定
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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した期間内にメ ッセージが読まれなかった
場合は、送信者に通知が送られます。

Show dialog during message 
encryption

暗号化する メ ッセージごとに暗号化オプ
シ ョ ン  ダイアログボッ ク スを表示するに
は、このオプシ ョ ンをオンにします。
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Encrypt by default このオプシ ョ ンを選択する と、送信するす
べての電子メール メ ッセージがデフォル
ト で暗号化されます。

Attachment name デフォル ト のエンベロープ名は 
securedoc.html です。添付ファ イル名の値は
変更でき、指定した新しい名前がエンベ
ロープに反映されます。

Message Security ド ロ ップダウン  リ ス ト から、暗号化する電
子メールのセキュ リ テ ィ を設定します。デ
フォル ト値は、BCE_Config.xml ファ イルで
設定された値です。

注 こ こで変更した メ ッセージ セキュ
リ テ ィは、作成中のメ ッセージに対
してのみ適用されます。

• [High]： メ ッセージに高度のセキュ リ
テ ィ を指定する と、暗号化されたメ ッ
セージを復号化するたびに認証用のパ
スワードが要求されます。

• [Medium]： メ ッセージに中程度のセ
キュ リ テ ィ を指定する と、受信者のパ
スワードがキャ ッシュ されている場合
は、そのメ ッセージを復号化する と き
にパスワードは要求されません。

• [Low]：メ ッセージに低いセキュ リ テ ィ
を指定した場合、送信は安全に行われ
ますが、暗号化されたメ ッセージを復
号化する と きにパスワードが要求され

[General] のオプシ ョ ン 値
4-25
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ません。

Send return receipt 受信者が送信された電子メールが開いた
と きに受信確認を要求するには、このオプ
シ ョ ンを選択します。
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[Conne
ction] タブ

次の図は、[Flag Encryption Options] の [Connection] タブを示しています。

次の [Connection] のオプシ ョ ンから選択します。

[Connection] のオプシ ョ ン 値

No proxy プロキシを使用しない場合に選択します。

Use system proxy settings デフォル ト のシステム  プロキシ設定を使
用する場合に選択します。

Manual proxy configuration 特定のプロキシの設定を入力する場合に
選択します。

Protocol デフォル ト の接続設定を使用しないこ と
を選択した場合は、[HTTP]、[SOCKS4]、
[SOCKS4a]、[SOCKS5] のいずれかのプロ
ト コルを選択します。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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Host システムまたはプロキシ  サーバのホス ト
名または IP アド レスを指定します。

Port システムまたはプロキシ  サーバのポート
を指定します。
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[Remem
ber Password] タブ

次の図は、[Flag Encryption Options] の [Remember password] タブを示してい
ます。

次の [Remember Password] のオプシ ョ ンから選択します。

User Name サーバでユーザ名が必要な場合に、ユーザ
名を入力します。

Password システムまたはプロキシ  サーバに対して
入力したユーザ名に関連するパスワード
を入力します。

[Connection] のオプシ ョ ン 値

パスワードのオプシ ョ ン 値

Never このオプシ ョ ンを選択する と、電子メール
4-27
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を復号化または暗号化する と きに、常に暗
号化パスワードが必要にな り ます。
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[Advan
ced] タブ

次の図は、[Flag Encryption Options] の [Advanced] タブを示しています。

注 ス ク リーンシ ョ ッ ト と表には [General] タブの使用可能なオプシ ョ ンがす
べて示されていますが、表示されるオプシ ョ ンは BCE_config.xml ファ イル
の設定に応じて異な り ます。

Always このオプシ ョ ンを選択する と、最初に電子
メールを復号化または暗号化する と きに
のみ、暗号化パスワードが必要にな り ま
す。パスワードはキャ ッシュ されます。

Minutes 暗号化パスワードがキャ ッシュ されるよ
うにするには、このオプシ ョ ンをオンにし
ます。ド ロ ップダウンから、キャ ッシュし
ておく期間（分数）を選択します。指定した
時間が経過する と、エン ド  ユーザは、電子
メールを復号化した り暗号化する際に暗
号化パスワードの再入力が必要にな り ま
す。デフォル トは 1440 分です。

パスワードのオプシ ョ ン 値
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次の [Advanced] のオプシ ョ ンから選択します。
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[Advanced] のオプシ ョ ン 値

Unsecure server URL メ ッセージ バーのヘルプで使用する非セ
キュア  ベース  URL。このオプシ ョ ンを省略
した場合は、外部のセキュア  URL
（http://res.cisco.com） が使用されます。

Connection timeout キー サーバへの接続が確立されるまでに
待機する時間の長さ。

Socket timeout キー サーバからのデータを待機する時間
の長さ。

Display "Open offline" check 
box

このオプシ ョ ンを選択する と、エンベロー
プに [Open offline] チェ ッ クボッ クスが表
示されます。

Display "Remember envelope 
key"

このオプシ ョ ンを選択する と、エンベロー
プに [Remember envelope key] チェ ッ ク
ボッ ク スが表示されます。

Display "Enable personal 
security phrase"

このオプシ ョ ンを選択する と、エンベロー
プに [Enable personal security phrase] チェ ッ
クボッ ク スが表示されます。

Show "Reply" button in the 
message bar

メ ッセージ バーが有効になっている場合、
メ ッセージ バーに [Reply] が表示されます。

Show "Forward" button in the 
message bar

メ ッセージ バーが有効になっている場
合、メ ッセージ バーに [Forward] が表示さ
れます。

Suppress applet for open アプレッ ト でエンベロープが開かれない
よ うにする場合に選択します。

Display "Remember me" このオプシ ョ ンを選択する と、エンベロー
プに [Remember me] チェ ッ クボッ クスが表
示されます。
4-29
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Display "Auto open" このオプシ ョ ンを選択する と、エンベロー
プに [Auto open] チェ ッ クボッ ク スが表示
されます。

Add message bar セキュア  メ ッセージにメ ッセージ バーを
追加する場合に選択します。
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暗号
化された電子メールの送信

注 添付前の暗号化電子メールのデフォル ト の最大サイズは 7 MBですが、この
値は管理者が BCE_Config.xml ファ イルを使って変更できます。

エン ド  ユーザは電子メールの作成時に [Encrypt Message] ボタンをク リ ッ
クする こ とで、電子メールを安全に送信する こ とができます。セキュア  
メ ッセージを送信する前に、[Encrypt Message] ボタンがオンになっている
こ と を確認して ください。

[Encrypt Message] ボタンは、電子メールの作成時に使用できます。

次の図は、[Mail Compose] ページの [Encrypt Message] ボタン、および 
[Encryption Mail Options] ト グル ボタンを示しています。

Show "Reply to All" button in the 
message bar

メ ッセージ バーが有効になっている場合、
メ ッセージ バーに [Reply to All] が表示さ
れます。

Open in the same window エンベロープと同じウ ィ ン ド ウでセキュ
ア  メ ッセージを開く場合に選択します。

[Advanced] のオプシ ョ ン 値
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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[Encryption Mail Options] ページを表示するには、右下隅にある  [Cisco Email 
Security] ランチャをク リ ッ ク します。

[Encryption Mail Options] ページ：

注 ス ク リーンシ ョ ッ ト と表には [Encryption Mail Options] の使用可能なオプ
シ ョ ンがすべて示されていますが、表示されるオプシ ョ ンは 
BCE_config.xml ファ イルの設定に応じて異な り ます。

注 [Encryption Mail Options] を変更した場合、その変更は作成中の電子メール 
メ ッセージにのみ適用されます。

次のメール オプシ ョ ンから選択します。

[Encryption Mail Options] 説明

Allow Reply このオプシ ョ ンを選択する と、受信
者は暗号化電子メールに返信でき
るよ うにな り、返信の電子メール 
メ ッセージが自動的に暗号化され
4-31
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ます。

Allow Reply All このオプシ ョ ンを選択する と、受信
者は暗号化電子メールを受信した
全員に返信できるよ うにな り、返信
の電子メール メ ッセージが自動的
に暗号化されます。
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Allow Forward このオプシ ョ ンを選択する と、受信
者は暗号化電子メールを転送でき
るよ うにな り、転送する電子メール 
メ ッセージが自動的に暗号化され
ます。

Message Security ド ロ ップダウン  リ ス ト から、暗号化
する電子メールのセキュ リ テ ィ を
設定します。デフォル ト値は、
BCE_Config.xml ファ イルで設定さ
れた値です。

注 こ こで変更したメ ッセージ 
セキュ リ テ ィは、作成中の
メ ッセージに対してのみ適
用されます。

• [High]：メ ッセージに高度のセ
キュ リ テ ィ を指定する と、暗号
化されたメ ッセージを復号化す
るたびに認証用のパスワードが
要求されます。

• [Medium]：メ ッセージに中程度
のセキュ リ テ ィ を指定する と、
受信者のパスワードがキャ ッ
シュ されている場合は、その
メ ッセージを復号化する と きに
パスワードは要求されません。

• [Low]：メ ッセージに低いセキュ
リティを指定した場合、送信は安
全に行われますが、暗号化された

[Encryption Mail Options] 説明
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メ ッセージを復号化する と きに
パスワードが要求されません。
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返信
このオプシ ョ ンが無効になっていない場合は、エン ド  ユーザが [Send] をク
リ ッ クする と  [Secure Envelope Options] ページが表示されます。エラーおよ
び ト ラブルシューテ ィ ング（4-52 ページ）を参照して ください。

オプショ ンの伝播

メ ッセージを復号化する と、[Reply]、[Reply All]、または [Forward] オプ
シ ョ ンのすべての設定と  [Message Sensitivity] オプシ ョ ンのすべての設定
が元のメ ッセージから継承されます。これらは変更できません。次に例を
示します。

• デフォル ト では、メ ッセージは返信または転送される際に暗号化され
ます。

• [Reply]、[Reply All]、または [Forward] オプシ ョ ンを元のメ ッセージから
継承できない場合は、返信メ ッセージや転送メ ッセージを送信できず、
エン ド  ユーザが [Send] をク リ ッ クする とそのこ とが通知されます。

• エンド  ユーザが [Reply]、[Reply All]、または [Forward] オプシ ョ ンを実

Expiration ド ロ ップダウン  リ ス ト で、暗号化し
た電子メールの有効期限（日時）を
指定します。有効期限の日時を過ぎ
る と メ ッセージは期限切れとな り、
以降、受信者はそのメ ッセージを開
く こ とができな く な り ます。

Read By ド ロ ップダウン  リ ス ト で、受信者が
暗号化されたメ ッセージを読むと
予想される期限の日時を指定しま
す。指定した期間内にメ ッセージが
読まれなかった場合は、送信者に通
知が送られます。

[Encryption Mail Options] 説明
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行している と きは、元のメ ッセージに含まれている受信者を削除でき
ません。

• エンド  ユーザが [Reply]、[Reply All]、または [Forward] オプシ ョ ンを実
行している と きは、元のメ ッセージに含まれていない受信者を追加で
きません。
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• エンド  ユーザが [Reply]、[Reply All]、または [Forward] オプシ ョ ンを実
行している と きは、[To]、[Cc]、または [Bcc] フ ィールド間で受信者を混
在させた り、移動する こ とはできません。

• アカウン ト が [Decrypt Only] または [Flag Encrypt] に設定されている場
合は、返信メ ッセージや転送メ ッセージを送信できず、エン ド  ユーザが 
[Send] をク リ ッ クする とそのこ とが通知されます。

• アカウン トの [Message Sensitivity] を  [High] に設定する と、[Reply]、[Reply 
All]、または [Forward] のメ ッセージの機密性も  [High] になり ます。

• アカウン ト の [Message Sensitivity] を  [Medium] に設定する と、[Reply]、
[Reply All]、または [Forward] のメ ッセージの機密性も  [Medium] にな り
ます。

• アカウン トの [Message Sensitivity] を  [Low] に設定する と、[Reply]、[Reply 
All]、または [Forward] のメ ッセージの機密性も  [Low] になり ます。

• [Reply]、[Reply All]、または [Forward] のメ ッセージは [Sent Items] フォ
ルダに保存され、送信者によって復号化できます。

• BCE_Config_signed.xml ファ イルが含まれている メ ッセージを他のエン
ド  ユーザに転送する と、管理者から受け取る場合とは異な り、自動設定
が機能せず、エラーが返されます。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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[Secure Envelope Options] ページ：
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エンド  ユーザは次の [Secure Envelope Options] から選択できます。

エン ド  ユーザのアカウン ト に Flag 暗号化が設定されている場合は、組織
から送信される前に、電子メールに暗号化のフラグが設定されます。エン
ド  ユーザのアカウン ト にデス ク ト ップ暗号化が設定されている場合、電子
メールは、Exchange Server に送信される前に、デス ク ト ップで暗号化され
ます。

セキュア エンベロープのオプ
シ ョ ン  説明

Expire on このオプシ ョ ンを有効にする場合
に選択します。暗号化電子メールが
期限切れになる日時を指定します。
その日時を過ぎる と メ ッセージは
期限切れとな り、以降、受信者はそ
のメ ッセージを開く こ とができな
く な り ます。日時は送信者のローカ
ル タ イム  ゾーンに表示されます。

Request a Decryption Notification 送信者がメ ッセージの復号化通知
を要求できるよ うにな り ます。暗号
化されたメ ッセージが開封される
と、送信者に通知が送られます。

Language 通知テキス ト で使用する言語を選
択します。ド ロ ップダウン  リ ス ト か
ら言語を選択する と、その言語で受
信者通知が表示されるよ うにな り
ます。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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セキ
ュア メ ッセージの管理

[Manage Secure Messages] ページには、送信済みの暗号化電子メールが表示
されます。エン ド  ユーザはこのオプシ ョ ンを使用して、送信済みの暗号化
電子メールに対して次の操作を実行できます。

• 電子メールのロ ッ ク。エン ド  ユーザは、以前に送信した暗号化電子メー
ルをロ ッ クできます。また、ロ ッ クの理由を設定した り、メ ッセージが
すでにロ ッ ク されている場合はロ ッ クの理由を更新できます。受信者
はロ ッ ク された電子メールを開く こ とができな くな り ます。

• 電子メールのロ ッ ク解除。エン ド  ユーザは、以前に送信した暗号化電子
メールのロ ッ クを解除できます。これによって、受信者はその電子メー
ルを復号化できるよ うにな り ます。

• 有効期限の更新。エン ド  ユーザは、送信した暗号化電子メールに対して
有効期限を設定、更新、ク リ アする こ とができます。暗号化された電子
メールが期限切れになる と、受信者はその電子メールを復号化できな
く な り ます。

[Manage Secure Messages] ページにアクセスするには、次の手順を実行し
ます。

ステップ 1 変更する送信済みの暗号化電子メールを選択し、その電子メールを右ク
リ ッ ク して [Manage Secure Messages] メニューを表示します。

また、エン ド  ユーザは、暗号化された電子メールを復号化する と きに 
[Manage Secure Messages] メニューにアクセスできます。エン ド  ユーザが変
更対象の電子メールの送信者である場合は、ツールバーに [Manage Secure 
Messages] ボタンが表示されます。
4-37
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[Manage Secure Messages] メニューのオプシ ョ ン：

ステップ 2 [Manage Secure Messages] を選択します。エン ド  ユーザのパスワードが
キャ ッシュ されていない場合は、パスワードの入力を求める メ ッセージが
表示されます。

ステップ 3 受信者ごとにロ ッ クや有効期限のオプシ ョ ンを設定するには、送信済みの
暗号化電子メール メ ッセージを選択して右ク リ ッ ク し、[Manage Secure 
Messages] を選択します。

または
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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送信済みの暗号化電子メール メ ッセージを複数選択して右ク リ ッ ク し、
[Manage Secure Messages] を選択して、選択した暗号化電子メール メ ッセー
ジをすべてロ ッ ク します。

注 ツールバーから  [Manage Secure Messages] メニューにアクセスした場合は、
同時に 1 つのメ ッセージにのみ有効期限の設定を適用できます。
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安全
[Manage Secure Messages] ページ：

な電子メールの受信

デスク ト ップ暗号化プラグインは安全な電子メールを自動的に検出し、
Outlook 内でそれらの復号化を試みます。エン ド  ユーザが暗号化された
メ ッセージを受信した場合は、通常、エンベロープを開封するために暗号化
パスワードを入力する必要があ り ます。セキュア  メ ッセージには、[High]、
[Medium]、または [Low] のメ ッセージ セキュ リ テ ィ を設定できます。

注 パスワード保護されたセキュ リ テ ィ  メ ッセージを受信した場合、エン ド  
ユーザは、そのメ ッセージを開封するために、Cisco Registered Envelope 
Service（CRES）にユーザ アカウン ト を登録して設定しなければならないこ
とがあ り ます。サービスに登録する と、アカウン ト  パスワードを使用して、
受信するすべての登録済みエンベロープを開封できます。詳細については、
暗号化されたセキュア  メ ッセージを初めて開封する場合（4-45 ページ）を
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参照して ください。
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[Message Security High] ページ：
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[Message Security Medium] ページ：
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[Message Security Low] ページ：

次の表は、メ ッセージ セキュ リ テ ィのオプシ ョ ンを示しています。

メ ッセージ セキュリテ ィのオプ
シ ョ ン 説明

High メ ッセージに高度のセキュ リ テ ィ
を指定する と、暗号化されたメ ッ
セージを復号化するたびに認証用
のパスワードが要求されます。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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エンド  ユーザがロ ッ ク された（または期限切れの）セキュア  メ ッセージを
受信する と、そのこ と を通知する メ ッセージが [Message Security] ページに
赤い文字で表示されます。

Medium メ ッセージに中程度のセキュ リ テ ィ
を指定する と、受信者のパスワード
がキャ ッシュ されている場合は、そ
のメ ッセージを復号化する と きにパ
スワードは要求されません。

Low メ ッセージに低いセキュ リ テ ィ を
指定した場合、送信は安全に行われ
ますが、暗号化されたメ ッセージを
復号化する と きにパスワードが要
求されません。

メ ッセージ セキュリテ ィのオプ
シ ョ ン 説明
4-43
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暗号
封す
化されたセキュア メ ッセージを初めて開
る場合

暗号化されたセキュ リ テ ィ  メ ッセージを受信した場合、エン ド  ユーザは、
そのメ ッセージを開封するために、Cisco Registered Envelope Service
（CRES）にユーザ アカウン ト を登録して設定しなければならないこ とがあ
り ます。サービスに登録する と、アカウン ト  パスワードを使用して、受信す
るすべての暗号化されたセキュア  メ ッセージを開封できます。

暗号化されたセキュア  メ ッセージを初めて開封する場合は、次の手順を実
行します。

ステップ 1 メールボッ ク ス内の安全な電子メール メ ッセージをダブルク リ ッ ク しま
す。登録ボタンが付いた復号化ダイアログが表示されます。

ステップ 2 [Register] をク リ ッ ク して、Cisco Registered Envelope Service（CRES）に登録
します。
4-45
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ステップ 3 CRES の [New User Registration] ページに情報を入力して、オンラ イン登録
フォームを完了させます。
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CRES の [New User Registration] ページ：
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[New User Registration] のオプシ ョ ン：

フ ィールド 説明

Language オプシ ョ ン。ド ロ ップダウン  メニューか
ら、CRES アカウン ト で使用する言語を選
択します。デフォル ト では、登録ページは
英語で表示されますが、エン ド  ユーザは日
本語、英語、フランス語、ド イツ語、スペイ
ン語、ポル ト ガル語から選択できます。

First Name 必須です。CRES ユーザアカウン ト の名を
入力します。

Last Name 必須です。CRES ユーザアカウン ト の姓を
入力します。

Password 必須です。アカウン ト のパスワードを入力
します。パスワードは 6 文字以上と し、数字
とアルファベッ ト の両方を含める必要が
あ り ます。

注 パスワードを忘れた場合、エン ド  
ユーザはセキュ リ テ ィに関する質
問に正し く答える こ とによって、パ
スワードを リ セッ ト できます。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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ステップ 4 フォームの下部にある  [Register] をク リ ッ ク し、ユーザ アカウン ト を作成
します。

Personal Security Phrase 必須です。個人セキュ リ テ ィ  フレーズを入
力します。個人セキュ リ テ ィ  フレーズは、
パスワード  フ ィ ッシシングの脅威からエ
ン ド  ユーザを保護する上で役立ちます。登
録時に、エン ド  ユーザは自分とサービスだ
けが知っている短い個人セキュ リ テ ィ  フ
レーズを指定できます。この個人セキュ リ
テ ィ  フレーズは、エン ド  ユーザが受信した
登録済みエンベロープのパスワード  
フ ィールドをク リ ッ クする と表示されま
す。表示されない場合は、詳細情報の リ ン
クをク リ ッ ク して確認します。

注 エンド  ユーザが [Remember me on 
this computer] をオンにしていない
場合、個人セキュ リ テ ィ  フレーズは
表示されません。

Enable Personal Security 
Phrase

オプシ ョ ン。個人セキュ リ テ ィ  フレーズを
有効にするには、このチェ ッ クボッ ク スを
オンにします。

Security Questions 必須です。エン ド  ユーザは 3 つのセキュ リ
テ ィに関する質問を選択し、質問への回答
を入力して確認する必要があ り ます。これ
らの質問は、エン ド  ユーザがパスワードを
忘れた場合にパスワードを リ セッ トする
ために使用されます。

フ ィールド 説明
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注 複数のメールアド レスで登録済みエンベロープを受信する場合、エン ド  
ユーザは複数のユーザ アカウン ト を設定する必要があ り ます。各アド レス
ご とに個別のユーザ アカウン ト が必要です。
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ログ
ステップ 5 電子メール アカウン ト の受信ト レイをチェ ッ ク して、アカウン ト のアク
テ ィベーシ ョ ン  メ ッセージが届いている こ と を確認します。アクテ ィベー
シ ョ ン用電子メール メ ッセージ内の [Click here to activate this account] リ ン
クをク リ ッ ク します。メ ッセージが表示され、アカウン ト のアクテ ィベー
シ ョ ンが確認されたこ と、および登録済み電子メール アド レスに送信され
た暗号化電子メールをエンド  ユーザが表示できるよ うになったこ とが示
されます。

ステップ 6 元の電子メールに戻り、securedoc_date_time.html 添付ファ イルをク リ ッ ク
します。

ステップ 7 [Open] をク リ ッ ク します。安全な電子メールが復号化され、そのメ ッセージ
が表示されます。

注 エンド  ユーザのコンフ ィギュレーシ ョ ン  ファ イルの設定によっては、一部
の機能が使用できないこ とがあ り ます。たとえば、メ ッセージの返信、全員
に返信、または転送ができない場合があ り ます。

パスワードは Outlook セッシ ョ ン中に保存されます。ただし、Outlook を再起
動したと きに、エンド  ユーザはパスワードを再入力する必要があ り ます。

設定の変更
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ログファ イルには、すべての発生したアクシ ョ ンが記録され リ ス ト化され
ています。

ロギング  オプシ ョ ンは [Cisco Email Security] ページにあ り ます。ロギング  
オプシ ョ ンを変更するには、次の手順を実行します。
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• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] > [Logging Options] の順に移動します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] > 
[Logging Options] の順に移動します。

Cisco Email Security の [Add-in Options] ページ：

暗号化の [Logging Options] ページ：
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ロギ

エラ
ング オプショ ン

エンド  ユーザは [Logging] メニューで次のオプシ ョ ンを設定できます。

エン ド  ユーザは、特定の状況に応じた ト ラブルシューテ ィ ングのレベルに
基づいてログ  レベルを変更できます。たとえば、Cisco IronPort Email 
Security Plug-in に関する問題が発生した場合、エン ド  ユーザがログ  レベル
を  [Extended] に設定する と管理者に最大限の情報を提供できるので、開発
者は問題を再現して診断を実行する こ とができます。

ーおよびト ラブルシューティング
こ こでは、Cisco IronPort Email Security Plug-in for Outlook の使用時に発生す
る可能性があるいくつかの一般的なエラー、およびそれらのエラーの修正
に役立つト ラブルシューテ ィ ングのヒ ン ト を示します。

オプシ ョ ン 説明

Log file name エンド  ユーザは ログ  ファ イル
（%ALLUSERSPROFILE%\Cisco\Cisco IronPort Email 
Security Plug-in\<username> に保存）の名前を指定でき
ます。ログ  ファ イル名の最後には、.log 拡張子を付ける
必要があ り ます。

Log level • [Normal]。 デフォル ト で、このオプシ ョ ンは有効に
なっています。Normal ロギングには、致命的エ
ラー、回復可能エラー、警告、役立つ情報が記載さ
れます。

• [Extended]。 Extended ロギングでは、Normal ログ  
メ ッセージに加えて、デバッグ  ログ  メ ッセージを
使用できます。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド

OL-22158-03-J

注 同じエラー メ ッセージを複数回受け取り、そのエラーによって  Cisco 
IronPort Email Security Plug-in が機能しな くなった場合、エン ド  ユーザは修
復プロセスを実行できます。Cisco Email Security Plug-in for Outlook ファ イ
ルの修復（4-57 ページ）を参照して ください。修復プロセスを実行しても同
じエラーが発生する場合は、手順に従って診断ツールを使用し、シスコに
フ ィードバッ ク して ください。Cisco IronPort Email Security 診断ツールの実
行（4-59 ページ）を参照して ください。
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Outl

コン

ソリュ

コン

ソリュ
ook の起動時に発生するエラー

フ ィギュレーショ ン ファイルの初期化中に発生するエラー

Outlook の起動時に次のメ ッセージが表示される こ とがあ り ます。

• An error occurred during <file_name> configuration file initialization. Some 
settings have been set to the default values. 

• Config validation for account <account_address> has failed. Please set the 
correct configuration values or contact your administrator. 

これらのエラー メ ッセージは、一部の設定値が無効な場合、または 
%ALLUSERSPROFILE%\Cisco\Cisco IronPort Email Security 
Plug-In\<username> フォルダ内の一部のコンフ ィギュレーシ ョ ン  ファ イル
が破損している場合に表示されます。

ーション

Cisco IronPort Email Security Plug-in は、破損したコンフ ィギュレーシ ョ ン  
ファ イルに含まれている一部の暗号化オプシ ョ ンのデフォル ト値を復元し
ません。代わりに、一部の暗号化機能をオフにします。エラー メ ッセージが
繰り返し表示される場合は、修復プロセスを実行してコンフ ィギュレー
シ ョ ン  ファ イルを修正して ください。Cisco Email Security Plug-in for 
Outlook ファ イルの修復（4-57 ページ）を参照して ください。

フ ィギュレーショ ン ファイルが見つからない

Outlook の起動時に次のエラー メ ッセージが表示される こ とがあ り ます。

• <file_name> configuration file was not found. Settings have been set to the 
default values. 

ーション
4-53
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド

158-03-J

Cisco IronPort Email Security Plug-in は、破損したコンフ ィギュレーシ ョ ン  
ファ イルに含まれている一部の暗号化オプシ ョ ンのデフォル ト値を復元し
ません。代わりに、暗号化モードを設定します。エラー メ ッセージが繰り返
し表示される場合は、修復プロセスを実行してコンフ ィギュレーシ ョ ン  
ファ イルを修正して ください。Cisco Email Security Plug-in for Outlook ファ
イルの修復（4-57 ページ）を参照して ください。
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メ ッ

Outlo

ソリュ

サーバ

ソリュ
セージ報告エラー

ok が 1 つ以上の名前を認識しない

エンド  ユーザが Outlook で [Spam]、[Virus]、[Phish]、または [Not Spam] ボタ
ンをク リ ッ ク したと きに、次のメ ッセージが表示される こ とがあ り ます。

• There was error during email reporting. Description: Outlook does not 
recognize one or more names. 

このエラーは、エン ド  ユーザがレポート  プラグインを使用しており、電子
メール メ ッセージの報告を試みている と きに、Outlook がそのメ ッセージ
の形式を認識できない場合に発生します。エン ド  ユーザは、スパムや
フ ィ ッシング  メールを報告できるよ うに（および、正当なメールを「非スパ
ム」と報告できるよ うに）、レポー ト  プラグイン  ファ イルを修復する必要が
あ り ます。

ーション

修復プロセスを実行します。Cisco Email Security Plug-in for Outlook ファ イ
ルの修復（4-57 ページ）を参照して ください。

に接続できない

エンド  ユーザが Outlook で [Spam]、[Virus]、[Phish]、または [Not Spam] プラ
グイン  ボタンをク リ ッ ク し、IMAP プロ ト コルまたは「headers only」Outlook 
プロパテ ィ を使用する と、次のメ ッセージが表示される こ とがあ り ます。

• Error: The connection to the server is unavailable. Outlook must be online or 
connected to complete this action. 

このエラーは、エン ド  ユーザが部分的に（ヘッダーのみ）ダウンロード した
メ ッセージの報告を試み、メール サーバへの接続が切断された場合に発生
します。レポー ト  プラグインでは、部分的にダウンロード した メ ッセージ
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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は報告できません。報告する メ ッセージ全体がダウンロード されるまで、
メール サーバへの接続が試みられます。

ーション

ヘッダーだけのメ ッセージを報告するには、事前に Outlook を メール サー
バに接続しておく必要があ り ます。
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サーバ

ソリュ

復号

アカ

ソリュ

アカ

ソリュ
への接続中にエラーが発生

Outlook がオンラ イン状態のと きに、インターネッ ト接続が失われた場合ま
たはサーバが一時的に使用できない場合は、次のエラーが発生します。

• An HTTP error occurred during connection to server.

ーション

ネッ ト ワークの設定を確認するか、ローカル管理者に連絡して ください。

化および暗号化に関するエラー

オプシ ョ ンを無効にしていない場合は、[Send] をク リ ッ クする と  [Secure 
Envelope Options] ページが表示されます。電子メール アカウン ト で次のよ
う なステータス  メ ッセージを受信する こ とがあ り ます。

ウン トがロックされている場合

• Your account has been locked. Please contact your account administrator for 
more information.

ーション

システム管理者に電子メール アカウン トのロ ッ ク解除を依頼して ください。

ウン トがブロックされている場合

• Your account has been blocked and you must reset your password. Please use 
the forgot password link to reactivate your account. Forgot password?

ーション
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パスワード  リ ンクをク リ ッ ク して、パスワード  セキュ リ テ ィの確認用の質
問に正し く回答し、パスワードを リ セッ ト して ください。
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アカ

ソリュ

受信者

復号化

ソリュ

暗号化
ウン トが一時停止された場合

• You have no attempts remaining. Your account is locked for the next 15 minutes.

ーション

後で https://res.cisco.com/websafe にログインを試みるか、サポート
（https://res.cisco.com/websafe/help?topic=ContactSupport）に連絡してサポー
ト を受ける こ とができます。

が未設定

送信する電子メールに受信者が記入されていない場合、次のメ ッセージを
受け取る こ とがあ り ます。

• An error occurred during encryption: no recipients specified.

中にエラーが発生

メ ッセージの復号化中に予期しないエラーが発生しました。たとえば、SDK 
によって不明なエラー コードを返された り、プラグインによって例外が報
告されます。

• An error occurred during decryption.

ーション

診断ツールを実行して、サポート  チームに診断レポート を送信して くださ
い。Cisco IronPort Email Security 診断ツールの実行（4-59 ページ）を参照して
ください。

中にエラーが発生
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メ ッセージの暗号中に予期しないエラーが発生しました。たとえば、SDK 
によって不明なエラー コードを返された り、プラグインによって例外が報
告されます。

• An error occurred during encryption.

https://res.cisco.com/websafe
https://res.cisco.com/websafe/help?topic=ContactSupport
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ソリュ

上限

Cisc
ーション

診断ツールを実行して、サポート  チームに診断レポート を送信して くださ
い。Cisco IronPort Email Security 診断ツールの実行（4-59 ページ）を参照して
ください。

を超過

添付前の暗号化電子メールのデフォル ト の最大サイズは 7 MBですが、この
値は管理者が BCE_Config.xml ファ イルを使って変更できます。暗号化電子
メールが最大値を超えている場合は、次のいずれかのメ ッセージを受け取
り ます。

• This message exceeds the allowable limit and cannot be decrypted.

• This message exceeds the allowable limit and cannot be encrypted.

• An error occurred during encryption: an invalid attachment found.

• Failed to report this message. This message is too large.

• Failed to report {0} messages. {0} messages are too large.

注 最後の 2 つのメ ッセージ（Failed to report ... ）は、 現時点では英語でのみ表示
されます。

o Email Security Plug-in for Outlook ファイルの修復

Cisco Email Security Plug-in を修復するには、次の手順を実行します。

ステップ 1 Outlook が終了している こ と を確認します。

ステップ 2 [Control Panel] > [Add or Remove Programs] を選択します。
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ステップ 3 プログラムの一覧から「Cisco IronPort Email Security Plug In」を選択し、
[Uninstall/Change] をク リ ッ ク します。

ステップ 4 [Repair] をク リ ッ ク します。インス トーラの修復プロセスが実行されます。
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診断
ティ
注 暗号化の設定は復元した り修正した りできません。暗号化の設定は、管理者
のみが BCE_Config.xml ファ イルを使って送信できます。

ステップ 5 エラーの原因になったアクシ ョ ンを実行します。修復プロセスの実行後も
同じエラーが発生する場合は、手順に従って診断ツールを使用し、Cisco 
IronPort にフ ィードバッ ク して ください。Cisco IronPort Email Security 診断
ツールの実行（4-59 ページ）を参照して ください。

ツールを使用したト ラブルシュー
ング

Cisco IronPort Email Security Plug-in には、問題の ト ラブルシューテ ィ ング時
にシスコのサポート を支援する診断ツールが用意されます。診断ツールを
使ってプラグイン  ツールから重要なデータを収集し、それらをシスコ  サ
ポート に送る と問題の解決に役立ちます。

エラーが発生した場合や、修復手順では解決できない Cisco IronPort Email 
Security Plug-in に関する問題が発生した場合、エン ド  ユーザは診断ツール
を使用できます。また、診断ツールを使用する と、不具合の報告時にシスコ
のエンジニアと重要情報を共有する こ と もできます。

Cisco Email Security Plug-in for Outlook ファ イルの修復（4-57 ページ）または
Cisco IronPort Email Security 診断ツールの実行（4-59 ページ）を参照して く
ださい。

注 エラーが発生した場合は、エラーおよびト ラブルシューティング（4-52 ページ） 
のト ラブルシューティングのヒン ト を参照してください。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド

OL-22158-03-J



OL-22

第 4 章      Cisco IronPort Email Security Plug-in for Outlook の設定と使用

Cisc
デー

Cisc

Outlo
o IronPort Email Security 診断ツールにより収集される
タ

診断ツールは、ご使用のコンピュータから次の情報を収集します。

• 一部の COM コンポーネン ト に関する登録情報

• 環境変数

• Cisco IronPort Email Security Plug-in の出力ファ イル

• Windows および Outlook に関する情報

• システム  ユーザ名および PC 名

• その他の Outlook プラグインに関する情報

• Outlook に関連する  Windows イベン ト  ログのエン ト リ

o IronPort Email Security 診断ツールの実行

Cisco Email Security 診断ツールは、次のいずれかの場所から実行できます。

• Cisco Email Security の [Options] タブから。通常は、Cisco Email Security 
の [Options] タブから診断ツールを実行します。

• 「Program Files\ Cisco IronPort Email Security Plug-in」フォルダから
（通常は、C:\Program Files\Cisco\Cisco IronPort Email Security Plug-in）。こ
れは Cisco IronPort Email Security Plug-in がインス トールされている
フォルダです。

• [Start Menu] > [All Programs] > [Cisco IronPort Email Security Plug-in] > 
[Cisco IronPort Email Security Plug-in Diagnostic] から。

ok の [Options] ページからの診断ツールの実行
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ステップ 1 診断ツールを実行するには、次のよ うに移動します。

• Outlook 2010 では、[File] > [Options] > [Add-ins] > [Add-in Options] > 
[Cisco Email Security] > [Run Diagnostic] の順に移動します。

• Outlook 2003/2007 では、[Tools] > [Options] > [Cisco Email Security] > 
[Run Diagnostic] の順に移動します。
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Cisco Email Security の [Add-in Options] ページ：

ステップ 2 診断ツールがデータを収集するまで数秒間待ちます。診断ツールがデータ
を収集し終わったら、データが正常に収集されたこ とを示すメ ッセージが
表示されます。

診断ツールによ り、CiscoDiagnosticReport.zip ファ イルが生成され、現在の
ユーザの My Documents フォルダに保存されます。そのファ イルは、エン ド  
ユーザからシステム管理者に送信した り、管理者からシスコのサポート担
当者に送信する こ とができます。レポー ト を表示するには、
CiscoDiagnosticsReport.zip ファ イルをダブルク リ ッ ク します。
Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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am Files からの診断ツールの実行

次の 2 種類の方法で Program files から診断ツールを実行できます。

• [Start] > [Programs] > [Cisco IronPort Email Security Plug-in] > [Cisco 
IronPort Email Security Plug-in Diagnostic] から診断ツールを実行します。

または 

• Cisco IronPort Email Security Plug-in をインス トールしたフォルダ（通
常、C:\Program Files\Cisco\Cisco IronPort Email Security Plug-in）に移動
し、Cisco.EmailSecurity.Framework.Diagnostic.exe ファ イルをダブルク
リ ッ ク します。

o IronPort Email Security Plug-in のアンインス
ル

Cisco IronPort Email Security Plug-in をアンインス トールするには、[Control 
Panel] > [Add/Remove Program] オプシ ョ ンを使用するか、setup.exe プログラ
ムを実行します。

アンインス トールする と、次の項目が削除されます。

• プラグインによって作成されたすべてのレジス ト リ  エン ト リ

• [Add/Remove Program] に一覧表示されているプラグインのエン ト リ

• プラグインに関連するファ イルの一部。すべてのファ イルが削除され
るわけではないので注意して ください。

• プラグイン  ツールバー（Outlook から削除）

注 プラグインをアンインス トールしても  Outlook のパフォーマンスには影響し
ません。アンインス トールする と きは Outlook を終了しておいてください。
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Cisco IronPort Email Security Plug-in for Outlook のアンインス トール手順：

Cisco IronPort Email Security Plug-in for Outlook をアンインス トールするに
は、次の 2 つの方法があ り ます。
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ステップ 1 [Start] > [Control Panel] > [Add/Remove Programs] をク リ ッ ク します。

ステップ 2 [Cisco IronPort Email Security Plug In] を選択し、[Uninstall/Change] > [Next] > 
[Remove] の順にク リ ッ ク します。

も う  1 つのアンインス トール方法： 

• プラグイン設定ファ イル（プラグインのインス トールに使用したファ
イル）をダブルク リ ッ ク し、[Remove] オプシ ョ ンを選択して、Cisco 
IronPort Email Security Plug-in をアンインス トールします。
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録は、次の項で構成されています。

isco IronPort Systems, LLC Software License Agreement（A-1 ページ）

 Systems, LLC Software License 

CE TO ALL USERS: CAREFULLY READ THE FOLLOWING LEGAL 
EMENT ("AGREEMENT") FOR THE LICENSE OF THE SOFTWARE 
EFINED BELOW). BY CLICKING THE ACCEPT BUTTON OR 
RING "Y" WHEN PROMPTED, YOU (EITHER AN INDIVIDUAL OR A 
LE ENTITY, COLLECTIVELY, THE "COMPANY") CONSENT TO BE 

D BY AND BECOME A PARTY TO THE FOLLOWING AGREEMENT 
EEN CISCO IRONPORT SYSTEMS, LLC, A DELAWARE 
ORATION ("IRONPORT") AND COMPANY (COLLECTIVELY, THE 
IES"). BY CLICKING THE ACCEPT BUTTON OR ENTERING "Y" 
 PROMPTED, YOU REPRESENT THAT (A) YOU ARE DULY 
A-1
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ORIZED TO REPRESENT YOUR COMPANY AND (B) YOU ACCEPT 
ERMS AND CONDITIONS OF THIS AGREEMENT ON BEHALF OF 
 COMPANY, AND AS SUCH, AN AGREEMENT IS THEN FORMED. IF 

OR THE COMPANY YOU REPRESENT (COLLECTIVELY, 
PANY") DO NOT AGREE TO THE TERMS AND CONDITIONS OF 
AGREEMENT, CLICK THE CANCEL BUTTON OR ENTER "N" WHEN 
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PROMPTED AND PROMPTLY (BUT NO LATER THAT THIRTY (30) DAYS 
OF THE DELIVERY DATE, AS DEFINED BELOW) NOTIFY IRONPORT, OR 
THE RESELLER FROM WHOM YOU RECEIVED THE SOFTWARE, FOR A 
FULL REFUND OF THE PRICE PAID FOR THE SOFTWARE.

1. DEFINITIONS

1.1 "Company Service" means the Company's email or internet services provided 
to End Users for the purposes of conducting Company's internal business and 
which are enabled via Company's products as described in the purchase 
agreement, evaluation agreement, beta or pre-release agreement, purchase order, 
sales quote or other similar agreement between the Company and IronPort or its 
reseller ("Agreement") and the applicable user interface and IronPort's standard 
system guide documentation that outlines the system architecture and its 
interfaces (collectively, the "License Documentation").

1.2 "End User" means the employee, contractor or other agent authorized by 
Company to access to the Internet or use email services via the Company Service. 

1.3 "Service(s)" means (i) the provision of the Software functionality, including 
Updates and Upgrades, and (ii) the provision of support by IronPort or its reseller, 
as the case may be.

1.4 "Software" means: (i) IronPort's proprietary software licensed by IronPort to 
Company along with IronPort's hardware products; (ii) any software provided by 
IronPort's third-party licensors that is licensed to Company to be implemented for 
use with IronPort's hardware products; (iii) any other IronPort software module(s) 
licensed by IronPort to Company along with IronPort's hardware products; and 
(iv) any and all Updates and Upgrades thereto.

1.5 "Updates" means minor updates, error corrections and bug fixes that do not 
add significant new functions to the Software, and that are released by IronPort or 
its third party licensors. Updates are designated by an increase to the Software's 
release number to the right of the decimal point (e.g., Software 1.0 to Software 
1.1). The term Updates specifically excludes Upgrades or new software versions 
marketed and licensed by IronPort or its third party licensors as a separate 
product.
 Cisco IronPort Email Security Plug-in 7.3 管理者ガイ ド
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1.6 "Upgrade(s)" means revisions to the Software, which add new enhancements 
to existing functionality, if and when it is released by IronPort or its third party 
licensors, in their sole discretion. Upgrades are designated by an increase in the 
Software's release number, located to the left of the decimal point (e.g., Software 
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1.x to Software 2.0). In no event shall Upgrades include any new versions of the 
Software marketed and licensed by IronPort or its third party licensors as a 
separate product.

2. LICENSE GRANTS AND CONSENT TO TERMS OF DATA COLLECTION

2.1 License of Software. By using the Software and the License Documentation, 
Company agrees to be bound by the terms of this Agreement, and so long as 
Company is in compliance with this Agreement, IronPort hereby grants to 
Company a non-exclusive, non-sublicensable, non-transferable, worldwide 
license during the Term to use the Software only on IronPort's hardware products, 
solely in connection with the provision of the Company Service to End Users. The 
duration and scope of this license(s) is further defined in the License 
Documentation. Except as expressly provided herein, no right, title or interest in 
any Software is granted to the Company by IronPort, IronPort's resellers or their 
respective licensors. This license and any Services are co-terminus.

2.2 Consent and License to Use Data. Subject to Section 8 hereof, and subject to 
the IronPort Privacy Statement at http://www.IronPort.com/privacy.html, as the 
same may be amended from time to time by IronPort with notice to Company, 
Company hereby consents and grants to IronPort a license to collect and use the 
data from the Company as described in the License Documentation, as the same 
may be updated from time to time by IronPort ("Data"). To the extent that reports 
or statistics are generated using the Data, they shall be disclosed only in the 
aggregate and no End User identifying information may be surmised from the 
Data, including without limitation, user names, phone numbers, unobfuscated file 
names, email addresses, physical addresses and file content. Notwithstanding the 
foregoing, Company may terminate IronPort's right to collect and use Data at any 
time upon prior written or electronic notification, provided that the Software or 
components of the Software may not be available to Company if such right is 
terminated.

3. CONFIDENTIALITY. Each Party agrees to hold in confidence all Confidential 
Information of the other Party to the same extent that it protects its own similar 
Confidential Information (and in no event using less than a reasonable degree of 
care) and to use such Confidential Information only as permitted under this 
A-3
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Agreement. For purposes of this Agreement "Confidential Information" means 
information of a party marked "Confidential" or information reasonably 
considered by the disclosing Party to be of a proprietary or confidential nature; 
provided that the Data, the Software, information disclosed in design reviews and 
any pre-production releases of the Software provided by IronPort is expressly 
designated Confidential Information whether or not marked as such.
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4. PROPRIETARY RIGHTS; OWNERSHIP. Title to and ownership of the 
Software and other materials and all associated Intellectual Property Rights (as 
defined below) related to the foregoing provided by IronPort or its reseller to 
Company will remain the exclusive property of IronPort and/or its superior 
licensors. Company and its employees and agents will not remove or alter any 
trademarks, or other proprietary notices, legends, symbols, or labels appearing on 
or in copies of the Software or other materials delivered to Company by IronPort 
or its reseller. Company will not modify, transfer, resell for profit, distribute, copy, 
enhance, adapt, translate, decompile, reverse engineer, disassemble, or otherwise 
determine, or attempt to derive source code for any Software or any internal data 
files generated by the Software or to create any derivative works based on the 
Software or the License Documentation, and agrees not to permit or authorize 
anyone else to do so. Unless otherwise agreed in writing, any programs, 
inventions, concepts, documentation, specifications or other written or graphical 
materials and media created or developed by IronPort or its superior licensors 
during the course of its performance of this Agreement, or any related consulting 
or professional service agreements, including all copyrights, database rights, 
patents, trade secrets, trademark, moral rights, or other intellectual property rights 
("Intellectual Property Right(s)") associated with the performance of such work 
shall belong exclusively to IronPort or its superior licensors and shall, in no way 
be considered a work made for hire for Company within the meaning of Title 17 
of the United States Code (Copyright Act of 1976).

5. LIMITED WARRANTY AND WARRANTY DISCLAIMERS

5.1 Limited Warranty. IronPort warrants to Company that the Software, when 
properly installed and properly used, will substantially conform to the 
specifications in the License Documentation for a period of ninety (90) days from 
the delivery date or the period set forth in the License Documentation, whichever 
is longer ("Warranty Period"). FOR ANY BREACH OF THE WARRANTY 
CONTAINED IN THIS SECTION, COMPANY'S EXCLUSIVE REMEDY AND 
IRONPORT'S ENTIRE LIABILITY, WILL BE PROMPT CORRECTION OF 
ANY ERROR OR NONCONFORMITY, PROVIDED THAT THE 
NONCONFORMITY HAS BEEN REPORTED TO IRONPORT AND/OR ITS 
RESELLER BY COMPANY WITHIN THE WARRANTY PERIOD. THIS 
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WARRANTY IS MADE SOLELY TO COMPANY AND IS NOT 
TRANSFERABLE TO ANY END USER OR OTHER THIRD PARTY. IronPort 
shall have no liability for breach of warranty under this Section or otherwise for 
breach of this Agreement if such breach arises directly or indirectly out of or in 
connection with the following: (i) any unauthorized, improper, incomplete or 
inadequate maintenance or calibration of the Software by Company or any third 
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party; (ii) any third party hardware software, services or system(s); (iii) any 
unauthorized modification or alteration of the Software or Services; (iv) any 
unauthorized or improper use or operation of the Software or Company's failure 
to comply with any applicable environmental specification; or (v) a failure to 
install and/or use Updates, Upgrades, fixes or revisions provided by IronPort or 
its resellers from time to time.

5.2 WARRANTY DISCLAIMER. THE EXPRESS WARRANTIES SET FORTH 
IN SECTION 5.1 OF THIS AGREEMENT CONSTITUTE THE ONLY 
PERFORMANCE WARRANTIES WITH RESPECT TO THE SOFTWARE OR 
SERVICES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 
LAW, IRONPORT LICENSES THE SOFTWARE AND SERVICES 
HEREUNDER ON AN "AS IS" BASIS. EXCEPT AS SPECIFICALLY SET 
FORTH HEREIN, IRONPORT AND ITS SUPERIOR LICENSORS MAKE NO 
REPRESENTATIONS OR WARRANTIES OF ANY KIND, WHETHER 
EXPRESS, IMPLIED, OR STATUTORY (EITHER IN FACT OR BY 
OPERATION OF LAW), AND EXPRESSLY DISCLAIM ALL OTHER 
WARRANTIES, INCLUDING WITHOUT LIMITATION, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. NEITHER IRONPORT NOR ITS THIRD PARTY LICENSORS 
WARRANT THAT THE SOFTWARE OR SERVICES (1) IS FREE FROM 
DEFECTS, ERRORS OR BUGS, (2) THAT OPERATION OF THE SOFTWARE 
WILL BE UNINTERRUPTED, OR (3) THAT ANY RESULTS OR 
INFORMATION THAT IS OR MAY BE DERIVED FROM THE USE OF THE 
SOFTWARE WILL BE ACCURATE, COMPLETE, RELIABLE AND/OR 
SECURE. 

6. LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, IN NO EVENT WILL EITHER PARTY BE LIABLE 
TO THE OTHER FOR ANY LOSS OF PROFITS, COSTS OF PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES, LOSS OF BUSINESS, LOSS OF 
USE OR DATA, INTERRUPTION OF BUSINESS, OR FOR INDIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND, 
EVEN IF SUCH PARTY RECEIVED ADVANCE NOTICE OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL THE LIABILITY 
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OF EITHER PARTY ARISING UNDER ANY PROVISION OF THIS 
AGREEMENT, REGARDLESS OF WHETHER THE CLAIM FOR SUCH 
DAMAGES IS BASED IN CONTRACT, TORT, OR OTHER LEGAL THEORY, 
EXCEED THE TOTAL AMOUNT PAID FOR THE SOFTWARE OR SERVICES 
DURING THE TWELVE (12) MONTHS PRIOR TO THE EVENT GIVING 
RISE TO SUCH LIABILITY. 
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7. TERM AND TERMINATION. The term of this Agreement shall be as set forth 
in the License Documentation (the "Term"). If IronPort defaults in the 
performance of any material provision of this Agreement or the License 
Documentation, then Company may terminate this Agreement upon thirty (30) 
days written notice if the default is not cured during such thirty (30) day period. 
If Company defaults in the performance of any material provision of this 
Agreement or the License Documentation, IronPort may terminate this 
Agreement upon thirty (30) days written notice if the default is not cured during 
such thirty (30) day notice and without a refund. This Agreement may be 
terminated by one Party immediately at any time, without notice, upon (i) the 
institution by or against the other Party of insolvency, receivership or bankruptcy 
proceedings or any other proceedings for the settlement of such Party's debts, (ii) 
such other Party making a general assignment for the benefit of creditors, or (iii) 
such other Party's dissolution. The license granted in Section 2 will immediately 
terminate upon this Agreement's termination or expiration. Within thirty (30) 
calendar days after termination or expiration of this Agreement, Company will 
deliver to IronPort or its reseller or destroy all copies of the Software and any 
other materials or documentation provided to Company by IronPort or its reseller 
under this Agreement.

8. U.S. GOVERNMENT RESTRICTED RIGHTS; EXPORT CONTROL. The 
Software and accompanying License Documentation are deemed to be 
"commercial computer software" and "commercial computer software 
documentation", respectively, pursuant to DFAR Section 227.7202 and FAR 
Section 12.212, as applicable. Any use, modification, reproduction, release, 
performance, display or disclosure of the Software and accompanying License 
Documentation by the United States Government shall be governed solely by the 
terms of this Agreement and shall be prohibited except to the extent expressly 
permitted by the terms of this Agreement. Company acknowledges that the 
Software and License Documentation must be exported in accordance with U.S. 
Export Administration Regulations and diversion contrary to U.S. laws is 
prohibited. Company represents that neither the United States Bureau of Export 
Administration nor any other federal agency has suspended, revoked or denied 
Company export privileges. Company represents that Company will not use or 
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transfer the Software for end use relating to any nuclear, chemical or biological 
weapons, or missile technology unless authorized by the U.S. Government by 
regulation or specific license. Company acknowledges it is Company's ultimate 
responsibility to comply with any and all import and export restrictions, and other 
applicable laws, in the U.S. or elsewhere, and that IronPort or its reseller has no 
further responsibility after the initial sale to Company within the original country 
of sale.
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9. MISCELLANEOUS. This Agreement is governed by the laws of the United 
States and the State of California, without reference to conflict of laws principles. 
The application of the United Nations Convention of Contracts for the 
International Sale of Goods is expressly excluded. Nothing contained herein shall 
be construed as creating any agency, partnership, or other form of joint enterprise 
between the parties. Neither party shall be liable hereunder by reason of any 
failure or delay in the performance of its obligations hereunder (except for the 
payment of money) on account of (i) any provision of any present or future law or 
regulation of the United States or any applicable law that applies to the subject 
hereof, and (ii) interruptions in the electrical supply, failure of the Internet, 
strikes, shortages, riots, insurrection, fires, flood, storm, explosions, acts of God, 
war, terrorism, governmental action, labor conditions, earthquakes, or any other 
cause which is beyond the reasonable control of such party. This Agreement and 
the License Documentation set forth all rights for the user of the Software and is 
the entire agreement between the parties and supersedes any other 
communications with respect to the Software and License Documentation. The 
terms and conditions of this Agreement will prevail, notwithstanding any variance 
with the License Documentation or any purchase order or other written instrument 
submitted by a party, whether formally rejected by the other party or not. This 
Agreement may not be modified except by a written addendum issued by a duly 
authorized representative of IronPort, except that IronPort may modify the 
IronPort Privacy Statement at any time, in its discretion, via notification to 
Company of such modification that will be posted at 
http://www.IronPort.com/privacy.html. No provision hereof shall be deemed 
waived unless such waiver shall be in writing and signed by IronPort or a duly 
authorized representative of IronPort. If any provision of this Agreement is held 
invalid, the remainder of this Agreement shall continue in full force and effect. 
The parties confirm that it is their wish that this Agreement has been written in 
the English language only.

10. IRONPORT CONTACT INFORMATION. If Company wants to contact 
IronPort for any reason, please write to IronPort Systems, Inc., 950 Elm Avenue, 
San Bruno, California 94066, or call or fax us at tel: 650.989.6500 and fax: 
650.989.6543.
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